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OVERVIEW: OCULAR IRRITECTION ASSAY 
SCIENTIFIC BACKGROUND 

 
The proprietary Ocular Irritection assay is a standardized and quantitative in vitro test that can be 
employed to detect, rank, and predict the ocular irritation potential of cosmetics, consumer 
products, pharmaceuticals, and chemical raw materials. The Irritection test methods are based on 
the understanding that the corneal irritancy of chemicals is known to be related to their 
propensity to promote denaturation and disruption of corneal proteins. Consequently, the 
Irritection methods have been developed as in vitro tests that mimic these biochemical 
phenomena. The rest itself consists of two essential components. The first component is a 
membrane disc that permits controlled delivery of the test material to a reagent solution. The 
second component is a proprietary reagent solution that is composed of proteins, glycoproteins, 
lipids and low molecular weight components that self-associate to form a complex 
macromolecular matrix. These components are depicted schematically in Figure 1.1. 

 
 

Figure 1.1. The Ocular Irritection Model 
 
When the assay is actually performed, controlled mixing of the test material and the reagent 
solution during the assay incubation period promotes protein denaturation and disaggregation of 
the macromolecular matrix. The changes in protein structure that are induced by the test material 
are then quantified by measuring the resulting changes in turbidity (OD400) of the reagent 
solution. 
 
Analysis and interpretation of the resulting data is performed with a WindowsTM – based 
computer software program (Chapter 7) that has been developed by InVitro International. This 
program compares the increase in optical density (OD400) produced by the test material to a 
standard curve that is constructed by measuring the increase in OD400 produced by a set of 
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Calibration substances. These Calibrators have been selected for use in this test because their 
irritancy potential has been previously documented in a series of in vivo investigations. This 
approach permits calculation of an Irritection Draize Equivalent (IDE) score. The predicted in 
vivo classification of ocular irritants, based on this scoring system, is shown in Table 1.1. 
 

Table 1.1. Relationship of Irritection Draize Equivalent (IDE) Score to Irritancy Classification 
for the Ocular Irritection Test Method 

 
Irritection Draize Equivalent (IDE) Predicted Ocular Irritancy Classification 

0.0 – 12.5 Minimal Irritant 
12.5 – 30.0 Mild Irritant 
30.0 – 51.0 Moderate Irritant 
51.0 – 80.0 Severe Irritant 

 
 

APPLICATIONS OF THE OCULAR IRRITECTION ASSAYS 
 
Two different versions of the Ocular Irritection Assays have been formulated. One version 
provides assessment of a broad range of irritants. This regular version of the test has successfully 
been employed for the following types of applications: industrial chemicals, cosmetics, 
petrochemicals, surfactants, and alkaline compounds. A second version of the test, termed the 
high sensitivity ocular assay, has been specifically developed to permit assessment of the 
irritancy potential of materials that display very little ocular irritancy. This test is normally 
employed to assess the irritancy of baby shampoos, certain cosmetics, and other minimal 
irritants. 
 
As described in Chapter 3, the experimental protocols that are utilized to determine the irritancy 
potential of these types of compounds generally fall into one of two different categories. 
Cosmetics, industrial chemicals, and petrochemicals that have a pH ≤ 8.5 are most commonly 
characterized by utilizing them to perform volume – dependent dose-response studies. By 
contrast, surfactants and surfactant-containing formulations are most successfully characterized 
by utilizing them to perform concentration-dependent dose-response studies. 
 
The Ocular Irritection assay system provides significant benefits when compared to the in vivo 
Draize test method. The quantitative Ocular Irritection in vitro assay has been found to be highly 
reproducible. Of even greater relevance, the Ocular Irritection assay method can be readily 
employed to evaluate multiple samples at varying volumes or concentrations. Thus, the test 
serves as an extremely useful screening tool that facilitates all stages of raw material selection, 
formulation development, and final product selection. 
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OVERVIEW: DERMAL IRRITECTION ASSAYS 
 

SCIENTIFIC BACKGROUND 
 

The proprietary Dermal Irritection assay is a standardized and quantitative in vitro test that can 
be employed to detect, rank, and predict the dermal irritation potential of cosmetics, consumer 
products, pharmaceuticals, and chemical raw materials. This assay, depicted schematically in 
Figure 1.2 below, is based on the principle that chemicals that cause dermal irritation are known 
to induce alterations in the structure of keratin, collagen and other dermal proteins. The dermal 
Irritection Assay System is an in vitro test that mimics these biochemical phenomena. Like the 
Ocular version of the test, the Dermal test also consist of two components. The first component 
is a membrane substrate that has been modified by covalently crosslinking a mixture of keratin, 
collagen and an indicator dye to it. The second component is a reagent solution consisting of a 
highly organized globulin/protein macromolecular matrix. 

 
Figure 1.2. The Dermal Irritection Model 

 
To perform this standardized assay, the test sample is applied to a synthetic biobarrier composed 
of a semi-permeable membrane containing a keratin-collagen matrix coated with a dye. 
Following application, the sample is absorbed by and permeates through this synthetic biobarrier 
to gradually come into contact with a proprietary solution containing highly-ordered globulins 
and glycoproteins. Reaction of the test sample with these proteins and macromolecular 
complexes promotes conformational changes that may be readily detected as an increase in the 
turbidity of the protein solution. In addition, the dye that has been dissociated from the biobarrier 
during transit of the applied sample may be detected spectrophotometrically. 
 
The extent of dye release and protein denaturation may be quantified by measuring the changes 
in optical density of the reagent solution at 470 nm (OD470). Comparison of these optical density 
measurements to those produced by standard chemical irritants permits calculation of a Human 
Irritancy Equivalent (HIE) score that has been shown to be directly related to the potential 
dermal irritancy of the test material. Analysis of the data and calculation of the HIE score is 
achieved with the Irritection computer software which includes programs that compare the 
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increase in optical density (OD470) produced by the test material to a standard curve that is 
constructed by measuring the increase in OD470 produced by a set of Calibration substances. The 
predicted in vivo classification, based on this scoring system, is shown in Table 1.2. 

Table 1.2. Relationship of Human Irritancy Equivalent (HIE) Score to Irritancy Classification 
for the Dermal Irritection Test Method 

 
Human Irritancy Equivalent (HIE) Predicted Dermal Irritancy Classification 

0.0 – 0.90 Non-Irritant 
0.90 – 1.20 Non-Irritant/Irritant 
1.20 – 5.0 Irritant 

 
 

APPLICATIONS OF THE DERAMAL IRRTECTION ASSAYS 
 

Like the Ocular Irritection assays, the Dermal Irritection assays have been formulated to 
characterize the irritancy potential of both typical dermal irritants and minimal irritants. The 
regular version of the test has been successfully employed to characterize anti-irritants, industrial 
chemicals, cosmetics, petrochemicals, and surfactants. The high  sensitivity version of the test 
has been utilized to characterize industrial chemicals, cosmetics, textile extracts, and other 
minimal irritants. 
 
The experimental protocols (Chapter 3) that are utilized to determine the irritancy potential of 
these types of compounds generally fall into one of two different categories. Cosmetics, 
industrial chemicals, and petrochemicals that have a pH ≤ 9.0 are most commonly characterized 
by utilizing them to perform volume-dependent dose-response studies. Alternatively, surfactants 
and surfactant-containing formulations are most successfully characterized by utilizing them to 
perform concentration-dependent dose-response studies. 
 
The Dermal Irritection assay system provides significant benefits when compared to in vivo test 
methods. The quantitative Dermal Irritection in vitro assay has been found to be highly 
reproducible. Of even greater relevance, the Dermal Irritection assay method can be readily 
employed to evaluate multiple samples at varying volumes or concentrations. Thus, the test 
serves as an extremely useful screening tool that facilitates all stages of raw material selection, 
formulation development, and final product selection. 
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DESCRIPTION OF KIT COMPONENTS 
 
Reagent Powder: When hydrated, forms a solution containing an ordered 

macromolecular matrix. Proteins in this solution undergo 
changes in conformation when exposed to an irritant. 

  
Hydrating Solution: Employed to rehydrate the reagent powder and facilitate 

formation of the ordered protein matrix. 
  
Blanking Buffer: Employed as a control solution which accounts for test sample 

background contribution to the assay. 
  
Activator (A): Lowers the pH of the reagent solution to the appropriate level to 

initiate formation of the ordered macromolecular matrix when 
the protein reagent has been rehydrated. 

  
Four Calibrators Labeled 
Cal 0, Cal 1, Cal 2 and Cal 3:  

Defined irritants that are employed in each assay to provide 
standardization and determination of irritancy equivalent scores. 

  
Tow Quality Controls 
Reagents (QC 1 and QC 2): 

Defined irritants that are employed in each assay as quality 
assurance controls to ensure proper performance of the assay. 

  
Inhibition Check (IC): A strongly irritating substance that is employed as a positive 

control to check for false negative results at the completion of 
each assay. 

  
Membrane Discs: A semi-permeable membrane that facilitates controlled delivery 

of the test sample into the protein regent. The Dermal Irritection 
membranes also incorporate a keratin/collagen matrix that has 
been corsslinked to a red dye which serves as a component in 
the overall reaction. 
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INTRODUCTION 
The Irritection assay system consists of newly-developed test kits, instrumentation and computer 
software that have been integrated to provide an automated in vitro testing capability that detects, 
predicts and ranks the ocular and dermal irritation potential of several types of materials. 
Because the system is reliable, rapid and cost-effective, it can be readily employed as a broad-
screen complement of a complete replacement for more variable, costly and time-consuming in 
vivo test methods. Consequently, the Irritection system is now being used as an efficient tool that 
substantially reduces the cost of developing products such as cosmetics, petrochemical 
formulations, surfactant-containing compounds and wide variety of consumer products. 
 

BACKGROUND: BIOCHEMICAL BASIS 
OF THE IRRITECTION TEST METHODS 

The original impetus for development of the Irritection system was the recognition that a need 
existed to prove in vitro test methods that could be reliably substituted for the Draize tests of 
ocular and dermal irrtancy.1 Consequently, investigators focused their studies on defining the 
mechanisms that were responsible for the corneal opacification and skin irritation that was 
observed in these in vivo tests and identifying potential biochemical substitutes for the corneal 
and dermal proteins that were effected by chemical irritants. These investigations eventually lead 
to development of the Eytex and Skintex test methods that were the forerunners of current 
Irritection system.2 
 
It is now understood that the Ocular Irritection tests are based on well-recognized biochemical 
mechanisms.3 Specifically, it has been demonstrated that the normal cornea is transparent, in 
large part because it is composed of proteins and carbohydrates that are highly organized. This 
precise organizational structure permits light to pass easily through the corneal, thus allowing 
clear vision. When chemical irritants are placed in the eye, they disrupt these organized proteins 
and produce the corneal cloudiness that is observed while performing the Draize test. The 
important contribution of InVitro International’s scientists has been the discovery that this 
process can be mimicked in vitro when irritants are applied to a unique mixture of proteins and 
glycoproteins. 
 
The major constituent of InVitro International’s proprietary Ocular Irritection protein reagent is 
an oligomeric protein consisting of 12 subunits. This oligomer has an apparent molecular weight 
of approximately 320kD. The protein oligomers tend to self-associate to form larger fibrils that 
are held together by noncovalent forces. The lyophilized Irritection reagent also contains 
carbohydrates, lipids and low molecular weight components. When the reagent is hydrated with 
a buffered salt solution, the oligomeric protein combines with other reagent constituents to form 
an ordered macromolecular matrix that mimics the highly ordered structures of the transparent 
cornea. 
 
Application of chemical irritants to the Irritection protein reagent produces biochemical changes 
that are similar to those observed in the cornea. For example, it has been demonstrated that 
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cationic and anionic surfactants produce both corneal opacification and increased turbidity of the 
Irritection reagent because these chemicals promote protein denaturation. Additionally, as the 
proteins become denatured, they unfold and change shape, a process which is termed changing 
conformation. As either the corneal or the Irritection proteins change conformation, they begin to 
disrupt the highly organized matrix structures that surround them. As this process proceeds, the 
proteins and matrix constituents gradually begin to form minute insoluble particles that re readily 
observed because the normally clear protein solutions gradually become cloudy. Figure 2.1 
depicts these types of changes schematically. 

 
Figure 2.1. Schematic Diagram Depicting Changes in the Irritection Protein 

Reagent that are Induced by Chemical Irritants 
 

These phenomena can be readily quantified by measuring the changes in light scattering that 
occur as the protein matrix becomes disrupted and the turbidity of the solution increases. In the 
Irritection system, this increase in light scattering is detected and quantified at a wavelength of 
400 nm (OD400) with a platereader spectrometer that has been specifically adapted for this 
purpose. 
 
Normally, as the concentration or volume of the tested irritant substance is increased, the 
Irritection protein reagent becomes more denatured and the amount of scattered light gradually 
increases until a maximal optical density is produced when all the proteins have become altered. 
As a result, chemical irritants typically produce a linear or sigmoidal dose-response curve when 
tested in the Irritection system. An example of such volume-dependent dose-response curve is 
shown in Figure 2.2 on the next page. 
 
By contrast, surfactants commonly produce a slightly different type of dose-response curve when 
analyzed with the Irritection system. To understand this phenomenon, it is important to recognize 

Ordered Mactomolecular 
Matrix 
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that surfactants function to solubilize organic substances in water because they are comprised of 
a hydrophobic “tail” and a hydrophilic “head”. When a surfactant “dissolves” an oil in water, it 
does so because its “tail” portion is soluble in the oil droplet and its “head” is soluble in water. 
When surfactants are analyzed with the Irritection system, they produce a bell-shaped does 
response curve that results from the fact that small quantities of surfactant will denature and 
disrupt the protein matrix to produce the expected increase in turbidity. However, as the amount 
of surfactant in the assay increases, the denatured proteins, which are organic molecules, are 
dissolved just as oil droplets would be. When this occurs, the opaque protein reagent is clarified 
and, as shown schematically in Figure 2.2, the OD400 decreases. 

 
Figure 2.2. Schematic Diagram Depicting the Dose-Response Curves 

Produced by Surfactants and Typical Chemical Irritants 
 
Chemical irritants and surfactants produce the most controlled and reproducible denaturation of 
proteins when they are gradually added to them. In the Ocular Irritection system, gradual 
addition of the test substance to the Irritection reagent is achieved by utilizing a membrane disc 
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of defined porosity as a delivery tool. Therefore, to analyze a substance with the Ocular 
Irritection system, the test substance is applied to the membrane delivery disc where it gradually 
diffuses through the porous membrane to mix with the protein reagent for a defined period of 
time. During this incubation period, the protein matrix undergoes the types of alternations 
described above. When the end-point has been reached, these changes are quantified by 
spectrometric methods and the results obtained with the test substance are compared with those 
obtained with a series of standard compounds that were analyzed under identical conditions. 
Incorporation of these calibration standards, whose irritancy potential has previously been 
defined by the Draize method, permits construction of a standard curve that directly relates the 
optical density measurement of the Irritection test to the maximum 24 hour Draize score 
determined by in vivo testing. An example of this type of standard curve is shown below in 
Figure 2.33 

 
Figure 2.3. An Example of a Standard Curve Demonstrating the Correlation Between 

Irritection Optical Density Measurements (OD400) and Draize Scores 
 

The results of these types of comparative studies have been utilized to develop what is termed 
the “Irritection Draize Equivalent (IDE)” score, i.e., a value derived from the in vitro studies that 
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is equivalent to the predicted in vivo irritancy score. An example of the comparison of these 
types of in vitro and in vivo scores for the Ocular test is shown below in Table 2.1. 

Predicated 
Ocular Irritancy 

Irritection Score 
(IDE) Range 

Draize 
Score Range 

Non-Irritant  0 – 5 
Minimal 0 – 12.5 >5 – 15 

Mild >12.5 – 30 >15-25 
Moderate >30 – 51 >25 – 50 

Severe >51 >50 
Table 2.1. Summary of the Relationship of Irritection and Draize Scores to 

Predicted Ocular Irritancy 
 

These type of derived scoring systems have proven to be very useful for facilitating inter-
laboratory comparative studies of different types of chemical and chemical formulations. 
 
The Dermal Irritection assay system, which is the enhanced version of the earlier Skintex test 
method, is also based on the principle that chemical irritants of the skin may be detected because 
they promote changes in relevant macromolecules and protein denaturation. However, this test 
method, which is depicted schematically in Figure 2.4, duffers significantly from the Ocular 
Irritection test in three ways. First, the synthetic biobarrier membrane of the Dermal test 

 
Figure 2.4.  Schematic Diagram Depicting The Dermal Irritection Assay System 

 
is somewhat more complex than the membrane delivery system of the Ocular test. Specifically, 
the Dermal biobarrier consists of a cellulosic membrane that has been coated with keratin and 
collagen in order to more closely duplicate the normal barrier properties of the dermis. 
Additionally, during the manufacturing process, a red dye is bound to these proteins. When the 
test is performed, release of this dye from the protein matrix by the test substance serves to 
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indicate disruption of the keratin/collagen biobarrier. Second, the composition of the protein 
mixture found in the Dermal test differs somewhat from that of the Ocular test in the structure of 
these proteins and dye release are quantified by measuring the absorbance at 470 nm (OD470) 
rather than at 400 nm as in the Ocular test. 
 

EVALUTION OF THE IRRITECTION TEST METHODS 
Extension investigations have been conducted to confirm the accuracy and reliability of both the 
Ocular and Dermal Irritection test systems. Most studies have focused on demonstrating that the 
earlier Eytex and Skintex versions of these tests provide results that correlate with in vivo 
findings. Two different approaches have been employed to confirm this correlation. In some 
cases, the data has been analyzed by performing a linear regression analysis. However, in most 
instances, because both the in vitro methods and the Draize methods do display inherent 
variation, concordance analysis, performed according to accepted statistical methods,4,5 has been 
employed to compare the in vitro and in vivo test results. 
 
As shown in Table 2.2, initial internal investigations conducted with a wide variety of different 
types of materials demonstrated a strong correlation between the results of the original Eytex test 
and Draize score. 

Product Class N Equivalence Sensitivity Specificity Predictive Value 
Consumer Household 54 92% 94% 100% 100% 
Consumer Personal 56 93% 95% 100% 100% 
Cosmetic Products 34 97% 83% 100% 100% 

Industrial Chemicals 67 96% 93% 100% 100% 
Industrial Products 102 96% 97% 96% 95% 

Pharmaceuticals 39 92% 100% 100% 100% 
Food Products 36 87% 84% 91% 84% 

Total 388 94% 95% 97% 98% 
Table 2.2.  Comparison of Ocular Irritancy Predicted by In Vitro and In Vivo Test methods: 

Summary of Concordance Analysis 
 

Similarly, investigations performed with the Skintex test, which was the forerunner of the current 
Dermal Irritection assay system, demonstrated a high degree of correlation with in vivo findings. 
The results of these studies are summarized below in Table 2.3. 

Product Class N Equivalence Sensitivity Specificity Predictive Value 
Consumer Household 84 85% 87% 81% 88% 

Cosmetic Products 238 95% 93% 96% 94% 
Industrial Chemicals 54 92% 93% 80% 95% 

Pharmaceuticals 33 85% 82% 88% 87% 
Total 409 92% 93% 88% 89% 

Table 2.3.  Comparison of Dermal Irritancy Predicted by In Vitro and In Vivo Test methods: 
Summary of Concordance Analysis 
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Subsequent studies conducted in collaboration with the FRAME Alternatives Laboratory at the 
University of Nottingham Medical School provided similar results. For these investigations, the 
irritancy potential of 53 different commonly-occurring laboratory chemicals was evaluated with 
the Eytex test method. The in vitro test was shown to have an equivalency of 88%, sensitivity of 
92%, specificity of 89%, and predictive value of 89%. 
 
Published scientific studies have confirmed the value of the Eytex version of the Irritection test 
methods. For example, in a study of 78 petrochemicals that had previously been evaluated with 
the Draize test, all 22 irritants were correctly classified as irritants by the Eytex method.6 
Additionally, 54 of 56 non-irritants were also correctly classified. There were no false negatives 
and only two false positives in the data set. The equivalence between the in vitro test and the 
Draize test was found to be 89% and the predictive value of the Eytex test was observed to be 
92%. A linear correlation analysis of the data provided a correlation coefficient of 0.76 
indicating that there was a significant correlation between the in vitro and in vivo test methods. 
 
The Eytex test has also been extensively evaluated in a double-blind study of 465 cosmetic 
product formulations and raw ingredients.7 the results of these studies are summarized in Figure 
2.5. 

 
Figure 2.5. Summary of Statistical Parameters Obtained from a Study 

Of 465 Cosmetics and Raw Ingredients 
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These findings obtained with over 30 different product types representing a wide range of 
irritancy clearly demonstrated that the Eytex test results were correlated with rabbit eye irritation 
data. A strong positive agreement on the in vitro and in vivo assay results was demonstrated by 
an overall concordance of 80%. Additionally, the finding of 100% sensitivity and 85% 
predictability indicated that the in vitro test effectively identified irritant cosmetics and their 
constituents. A compatibility rate of 99% demonstrated that the in vitro test was well-suited to 
accommodate a wide variety of different materials. 
 
The Eytex test has also been applied to assessing the irritancy potential of pharmaceutical 
intermediates.8 In this study of 37 test materials which were chosen to represent a broad range of 
pH, solubility and in vivo irritation potential, the Eytex test was demonstrated to have a 
concordance of 72.2% with the in vivo test. By contrast, these authors concluded that in vitro 
tests based on cellular and/or bacterial cytotoxicity end points did not correlate well with the in 
vivo data. 
Another recent study of 142 chemicals and chemical products conducted in eight different 
laboratories clearly demonstrated the correlation of the Eytex test results with those obtained by 
the Draize method.9 These investigations confirmed earlier observations that nearly all (93%) of 
the chemicals tested were compatible with the in vitro test method. Repeatability (6.3%) and 
reproducibility (8.9%) were found to be quite acceptable. More importantly, linear correlation 
analysis, as show below in Figure 2.6, demonstrated a statistically significant correlation 
(student’s t and Fisher’s test p<0.001) of the in vitro test results with the maximal 24 hour Draize 
score results. The sensitivity, specificity, and equivalence of the Eytex test were noted to be 
94%, 89%, and 78% respectively. 
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Figure 2.6. Correlation of In Vitro Draize Equivalent Scores with 

Maximal 24 Hour Draize Scores 
 
These authors concluded that the in vitro test method “exhibited the characteristics of a good 
screening method: compatibility with a large range of chemicals; a simple and rapid procedure; 
good laboratory and inter-laboratory reproducibility; coast effectiveness; high sensitivity, 
specificity and predictive value; and an low incidence of false negative and false positive 
results.” 
 
And important aspect of the development of the new Irritection test method was confirmation 
that this new test correlated well the previous Eytex test. This was achieved by utilizing four 
different laboratories to perform an inter-laboratory comparison of the two methods. As shown in 
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Figure 2.7, when the mean Draize equivalent scores obtained for the Irritection and Eytex tests 
were compared, the correlation between the two test methods was excellent. 

 
Figure 2.7. Comparison of Mean Eytex and Irritection 

Draize Equivalent Scores Obtained for 10 Reference Chemicals 
 

The two tests were also found to be similar with regard to reproducibility, with the Irritection test 
displaying a coefficient of variation of 12% and the Eytex test 9%. 
 
Taken together, these evaluations of the earlier Eytex and current Irritection systems clearly 
demonstrate the value of this test method as a reliable and reproducible means of providing both 
a numerical score and predicted irritant classification of a wide variety of chemicals, raw 
materials, cosmetics, and pharmaceutical intermediates. These in vitro tests display a good 
correlation with the in vivo data whether linear correlation or concordance analysis was utilized 
to predict irritancy class. The data suggests that concordance analysis provides a somewhat better 
correlation than linear regression analysis. This is to be expected because these in vitro test 
systems were specifically designed to predict irritancy classifications rather than provide 
absolute values. However, it is also clear that, for similar chemical formulations, the Irritection 
test is sufficiently sensitive and reproducible to allow accurate comparisons and rank-ordering of 
different formulation variations. 
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SUMMARY AND CONSLUSIONS 
 
In Vitro International’s newly-developed Irritection test system is an advanced in vitro test that 
can be employed to predict the irritancy potential of diverse chemicals, raw ingredients and 
consumer products. The performance of the Irritection system has been significantly enhanced 
when compared to the earlier Eytex and Skintex versions of this test. The advantages of the 
current test system include: increased reliability, convenience, and coast-effectiveness. In 
addition, the Irritection test is performed on instrumentation that is both more reliable and more 
flexible than that employed previously. The Irritection test also exhibits the reproducibility, 
sensitivity and specificity that is required of a valid in vitro method. 
 
The Irritection test may be used either alone or in combination with other tests for a wide variety 
of applications. Because the assays are broadly applicable, the Irritection system is best suited to 
serve as a screening tool that can be employed to facilitate formulation and product development 
activities. The test method possesses sufficient specificity and sensitivity to permit identification 
and rank ordering of potential irritants so these may be eliminated from consideration very early 
in the formulation process. Furthermore, the rapidity and cost-effectiveness of the Irritection 
assays in this setting make them an excellent replacement for animal testing in the early phases 
of the product development cycle. 
 
The Irritection tests are also well suited for both the initial and final phases of product 
development. For example, there is clear evidence that either the ocular or the dermal versions of 
the test may be employed as a quality assurance test method that serves to define the irritancy 
specifications for raw materials and other ingredients. This is particularly true if the materials are 
composed of complex mixtures of natural products that are not easily characterized by other 
analytical methods. The Irritection tests have also been utilized to confirm the safety of final 
product formulations, particularly in the cosmetics industry where adequate data bases have been 
compiled to support this application. 
 
The current application-specific Irritection products have been specifically designed to meet the 
needs of formulation and product development groups in a wide variety of different industries. 
These applications are summarized in Table 2.4. 
 

Ocular 
Assays 

High sensitivity 
Ocular Assays 

Dermal 
Assays 

High Sensitivity 
Dermal Assays 

Industrial Chemicals Baby Shampoos Anti-Irritants Industrial Chemicals 
Cosmetics Minimal Irritants Industrial Chemicals Cosmetics 

Petrochemicals Cosmetics Cosmetics Minimal Irritants 
Surfactants  Petrochemicals Textiles 

Alkaline Compounds  Surfactants  
Table 2.4. Current Irritection Assay Applications 
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In addition to these existing products, In Vitro International’s Customized Technology Services 
group is continually working with customers to develop and refine new applications of the core 
technology that are specifically designed to meet their requirements. 
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Irritection® Assay System Decision Tree 
 

 
 

Prior to analysis, please refer to “Incompatible Compound” List in 
Chapter 6 of Irritection® Assay System Instruction Manual 

Is the sample’s ph>0.9? 

YES NO 

Sample may not suitable for analysis. 
Irritancy may be underestimated. 

Run in Corrositex for 
dermal corrosion. 

Perform a Concentration-Dependent Study: 
Solid: 1, 2, 5, 8 and 15% 

Liquid: 1, 5, 10, 25, and 50% 

Is the sample surfactant? 

YES NO 

Perform a Volume–Dependent Study: 
25, 50, 75, 100, and 125 µl (liquid)/mg (solidl) 

Did you obtain “qualified” results? 

YES NO 

Report Classification. 
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OVERIVEW 
This chapter of the Irritection Assay System Instruction Manual contains four separate assay 
protocols. These experimental protocols provide a detailed description of the experimental 
methods that are routinely employed to analyze test samples in both the Ocular and Dermal 
versions of the Irritection test kits. 
 
As a general rule, most chemicals, petrochemicals, and cosmetics are best characterized by 
performing a volume-dependent does-response study. Detailed descriptions of these types of 
experimental protocols may be found on pages 3 through 26 of this chapter. By contrast, because 
of the phenomena described in the previous chapter, surfactants and surfactant-containing 
material are best characterized by utilizing concentration-dependent dose-response protocols. 
Detailed description of these types of experimental protocols may be found on pages 27 through 
50 of this chapter. 
 
As noted in Chapter 6 of this manual, extremely alkaline compounds may not be well suited for 
analysis with these test kits. If the pH of the test sample is >9.5 to 10.0, the sample should be 
partially neutralized with HCI prior to analysis. 
 
Abbreviated versions of these protocols have been prepared for each specific application of the 
Irritection Assay System and are included with each specific assay kits. Additional copies of 
these procedural summaries may be obtained contacting customer service at 1-800-2-INVITRO. 
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OCULAR RESPONSE ASSAY 
VOLUME-DEPENDENT DOSE-RESPONSE PROTOCOL 

(DRAIZE EQUIVALENT SCORING SYSTEM) 
In Vitro International’s Ocular Response Assay is an in vitro assay method that may be 
employed to determine and predict the ocular irritation potential of non-surfactant based 
chemical, and cosmetic samples. The results of this test have been shown to correlate with those 
obtained with the in vivo Draize test. Ocular Response findings may be related to the in vivo test 
results through the Irritection Draize Equivalent (IDE) scoring system that has been developed 
for this purpose. 
 
This assay protocol provides a detailed description of the experimental procedures that are 
required to perform the Ocular Response Assay. The protocol consists of five steps: 
 

1. Preparation of the samples 
 
2. Preparation of the Ocular protein reagent solution 

 
3. Set-up of the assay 

 
4. Incubation for 24 hours to permit reaction of the samples and protein reagent. 

 
5. Determination and interpretation of the assay results. 

 
The first three steps may be completed in approximately two hours. The final step, to be 
performed on the following day, may be completed in approximately one hour. 
 
Prior to beginning the assay, place the Hydrating Solution in a 25˚C incubator for 1 to 2 hours to 
ensure that it is approximately 25˚C. Remove the 24-well assay plates filled with membrane 
discs from the refrigerator. Allow the membrane discs to equilibrate to room temperature 
(approximately 30-45 minutes) before being used in Step III.D.3. 
 
I. Instrumentation, Reagents and Materials 

A. Kit Contains: 
1. Ocular Reagent Powder (1 Bottle) 
2. Ocular Hydrating Solution (1 Bottle) 
3. Ocular Blanking Buffer (1 Bottle) 
4. Ocular Inhibition check (1 Vial) 
5. Ocular Activator (1 Vial) 
6. Four Calibrator Solutions: Cal 0, Cal 1, Cal 2, Cal 3 
7. Two Quality Control Solutions: QC1, QC2 
8. 24-well Assay Plates Filled with Membrane Discs (48 clear discs)–store at 2-8˚C 

(2) 
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9. Wooden Stirring Sticks (12) 
10. Whatman #1 Filter Paper, 12.5 cm diameter (1) 
11. Procedural Summary 
12. Range Specification Data Sheet 
13. Irritection Software Instructions 
 

B. Additional Materials Required: 
1. Plate Reader (such as Modified Cambridge 7520 Microplatereader) 
2. IBM compatible PC with Irritection Software 
3. Incubator Maintained at 25˚C ± 1˚C 
4. Balance (110 g Capacity) 
5. pH Meter 
6. Vortex Mixer 
7. Positive Displacement Micro Pipettor (such as Labindustries PopetteTM 

Micropipettor Model P-250, 5 – 250 µl) 
8. Multichannel Pipettor (such as Matrix 6 Channel EXP Impact Pipettor 15-1250 

µl) 
9. Disposable Reservoir Trays (2—such as 100 ml Matrix Disposable Reagent 

Reservoir) 
10. 100 ml Graduated Cylinder 
11. 100 ml Beaker 
12. Funnel (such as Oxford Vented Disposable Polystyrene Funnel, 12.5 cm 

diameter) 
13. Plastic Forceps 
14. Plastic Wrap 
 

II. Sample Preparation 
A. Sample Preparation 

 
Typically, five samples may be analyzed at four volumes (50, 75, 100, 125 µl). 

1. If the sample is a liquid, dilute the sample to the desired concentration for 
analysis. 

2. If the sample is a solid, attempt to convert in to a liquid by gently warming it. If 
the sample melts with warming, apply the liquid molten following procedures 
detailed in Step III.D.3. 

3. If the sample is a solid that does not readily melt with warming, weigh out 50, 75, 
100, and 125 mg of each sample and place each amount directly into the 
membrane discs. (if you choose to evaluate 4 samples at 5 volumes, 25 mg should 
be used as the fifth weight for analysis.) This should be completed prior to 
rehydrating the Reagent as described in Section III.A below. 
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III. Procedures 
A. Ocular Reagent Preparation: 
 

1. Rehydration: 
a. Remove the Hydrating Solution from the 25˚C incubator. 
b. Using a funnel, pour the entire contects of the Hydrating Solution into 

the Reagent Powder bottle. 
c. Gently swirl until all of the Reagent Powder is dissolved. 
d. Let the dissolved Reagent stand at room temperature for approximately 

10 minutes before filtering. 
 

2. Filtration: 
a. Fold the filter paper and place in funnel. 
b. Pour all of the dissolved Reagent into the funnel and collect the filtrate 

in a graduated cylinder at atmospheric pressure (do not use a vacuum 
pump to collect filtrate). This will take approximately 10 minutes. 
Note: During the filtration process, label the 24-well assay plates 
(Step III.B). 

c. Pour 40 ml of the filtered Reagent into a 100 ml beaker. 
Note: The Reagent must be used within 30 minutes of rehydration. 
 

3. Activation: 
a. Record the initial pH and temperature of the filtered Reagent, verifying 

that it falls within the following specified ranges: pH: 7.91-8.19 and T: 
23-25˚C. 

b. Using the positive displacement pipettor, slowly add 800 µl of the 
Activator to the filtered Reagent. Gently swirl to mix. 

c. Record the final pH of the Activated Reagent solution, verifying that it 
falls within the following specified range: pH: 6.42-6.74. Note: If the 
pH does not fall within the specified range, recalibrate the pH meter, 
gently swirl the Reagent and remeasure the pH. If the pH is still not 
within the specified range, contact your technical representative at 1-
800-2-INVITRO. 

d. Using the positive displacement pipettor, slowly add 600 µl of the 
Activator to the bottle of Blanking Buffer. Gently swirl to mix. 

e. It is not necessary to measure the pH or temperature of the Activated 
Blanking Buffer. 
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B. Labeling the 24-Well Assay Plates: 
 

1. Remove the membrane discs from the assay plates and place them in a container. 
These discs will be used in Step D.1 

2. Align the assay plates with the notched corners toward the left and label their lids. 
A typical plate configuration that has been employed to evaluate five different 
samples at four different volumes is shows in Figure 3.1 on the next page. 
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Figure 3.1. Suggested Plate Configuration: Analysis of Five Samples at 

Four Different Volumes 
 
Figure Legend: 
 

 
 
 
   B 0:  1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 0:  1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 1:  1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to membrane disc. 
Cal 2:  1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to membrane disc. 
Cal 3:  1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to membrane disc. 
QC 1:  1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to membrane disc. 
QC 2:  1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to membrane disc. 

B:  1.25 ml Activated Blanking Buffer in well, 50, 75, 100 and 125 µl/mg of sample applied  
to membrane discs. 

S:  1.25 ml Activated Reagent in well, 50, 75, 100 and 125 µl/mg of sample applied to  
membrane discs. 

 
Note: Alternative assay schemes are shown in Figure 3.3 and 3.4 on pages 14 and 15 of the  

this chapter. 
 

C. Addition of Reagent and Blanking Buffer to 24-Well Assay Plates: 
 

1. Remove the labeled lid on each assay plate and use the lid or Figure 1 as a 
reference when filling the wells. 

2. Set the multichannel pipettor at 1250 µl. 

= well contains Blanking Buffer = well contains Reagent 
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3. Pour the Activated Reagent into a disposable reservoir tray. 
4. Using the multichannel pipettor, add 1250 µl of the Activated Reagent to the 

following wells: Cal 0, Cal 1, Cal 2, Cal 3, QC 1, QC 2 and all wells designated 
for analysis of the samples (S). 

5. Pour the Activated Blanking Buffer into a disposable reservoir tray. 
6. Change pipette tips and add 1250 µl of the Blanking Buffer to the wells 

designated B 0 on both plates and all other wells designated as blanks (B). 
 

D. Addition of Calibrators, Quality Controls and Samples: 
 
Note: Avoid cross contamination among the separate Calibrator, Quality 
Control and sample wells by utilizing a clean pipette tip for each. 
 
1. Pipette 125 µl of Cal 0 into a membrane disc and insert it into the B 0 well. 

Repeat this procedure for the B 0 well of the second assay plate, 
2. Pipette 125 µl of Cal 0, Cal 1, Cal 2, Cal 3, QC 1 and QC 2 into the membrane 

discs and insert them into the appropriate wells of the assay plates. 
3. If the sample is a liquid, pipette 50, 75, 100 and 125 µl of each test sample into 

the membrane discs and insert them into the corresponding blank and test sample 
wells of the assay plates. (If you wish to evaluate 4 samples at 5 volumes, 25 µl 
should be used as the fifth volume for analysis.) 

4. If the sample is a solid, insert the membrane discs which contain 50, 75, 100 and 
125 mg of each test sample into the corresponding blank and test sample wells of 
the plates. 

 
E. Incubation: 

 
1. Tightly wrap each assay plate with plastic wrap. Place a lid on top of each 

wrapped plate. 
2. Record the technician’s name, date and time on the lids of the assay plates. 
3. Place the assay plates in an incubator maintained at 25˚C ± 1˚C for 24 hours (± 30 

minutes). 
 

F. Removing Membrane Discs: 
 
1. Remove the assay plates from incubator. 
2. Remove the lids from the assay plates and save them. They will be used as a 

reference when transferring the Reagent and the blanking buffer to the clean 96-
well reading plate. 

3. Carefully remove the plastic wrap from each assay plate and use the forceps to 
remove each disc. 
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4. Check the membranes for damage. Verify that all membrane discs are intact. If 
membrane damage has occurred, it should be recorded. Data for this sample 
should be carefully evaluated. 

5. using the wooden stirring sticks, scrape the Reagent wells to ensure that all of the 
precipitate is removed from the bottom of each well. Use one stirring stick fro 
each sample, starting with lowest volume wells first, the progressing to wells of 
higher volume. Use a separate stirring stick for each calibrator well. The wells 
containing Blanking Buffer do not need to be scraped. 

 
G. Transferring 250 µl of Reagent and Blanking Buffer into the 96-well Reading Plate: 

 
1. Set the multichannel pipettor to 260 µl for dispensing. 

Note: 260 µl is used for filling to ensure that no air bubbles are dispensed.  
The remaining 10 µl must be purged prior to refilling the 
multichannel pipettor. 

2. Transfer 250 µl from each well of the 24-well assay plates to every other well of 
the 96-well reading plate by columns (see Figure 2, page 7). 

3. Change pipette tips and repeat this process for each column. 
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Figure 3.2. Transferring from 24-Well Assay Plates to 96-Well Reading Plate 

 
Figure Legend: 
 

 
 
 

= cell should be empty 

= cell should contain 250 µl of Reagent or Blanking Buffer from the 24-well assay 
plates 
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H. Reading Assay on Plate Reader (refer to the Irritection Software Instructions found in 
Chapter 7 for more details: 

 
1. To eliminate inaccurate readings produced by settling of the precipitated Reagent, 

the assay must be read immediately after transferring the Reagent to the reading 
plate. 

2. If you have the Irritection Software for DOS, follow the instructions listed in Step 
2a. If you have the Irritection Software for WindowsTM, follow the instructions 
listed in Step 2b. 

a. Irritection Software for DOS: 
(1) Ensure that the plate set up in the Irritection Software matches the 

configuration for the assay and that the Calibrator/Quality Control 
ranges in the software are updated with the current kit lot number. 

(2) Select New Assay Entry from the Assay menu to initiate plate 
reader. 

(3) Remove the reading plate lid, wipe the bottom of the plate with a 
Kimwipe to remove any moisture and insert the plate into the plate 
reader with the corner notches facing to the left. 

(4) Follow screen prompts to read and analyze data (read absorbance 
at 405 nm). 

(5) Upon completion of data entry, press F10 to process data. If an 
Inhibition Check needs to be performed, a screen prompt will 
display the appropriate wells that require inhibition check. 

 
b. Irritection Software for Windows: 

(1) From the Method menu, choose Select. 
(2) Select the appropriate assay method. 
(3) From the File menu, choose New. 
(4) Select Assay. 
(5) Select the appropriate protocol. 
(6) Select the appropriate plate layout. 
(7) A series of screens will be displayed. You will need to enter the 

appropriate assay, and sample information. 
(8) The plate reader will initialize. Remove the reading plate lid, wipe 

the bottom of the plate with a Kimwipe to remove any moisture 
and insert the plate into the plate reader with the corner notches 
facing to the left. Click Continue, or press ENTER. 

(9) After the data collection is completed, a dialog box will be 
displayed indicating if the assay was qualified or unqualified. Click 
OK to continue. 
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(10) If an Inhibition Check needs to be performed, a screen 
prompt will display the appropriate wells that require Inhibition 
Check. 

3. If an Inhibition Check is required, add 25 µl of Inhibition Check to the 
appropriate wells. 

4. Wait five minutes, then re-read. 
 
 

I. Irritection Software Qualification Checks: 
The Irritection software will perform the following qualification checks to ensure 
assay performance. 
1. Calibrator/Quality Control Check: Verifies that Calibrators/Quality Controls are 

within specified ranges. 
2. Net Optical Density Check: Verifies that Net OD (ODreagent – ODblank = ODNet) is 

> -15. 
3. Inhibition Check: Verifies that OD of Inhibition Check is greater than OD of Cal 

2. 
4. Dose Response Check: Verifies that sample dose response curve is either flat or 

has an increasing curve. 
 
 

J. Sample Results: 
1. Upon acceptance of all qualification checks, the Irritection Software will generate 

a qualified assay report. 
2. Irritection Draize Equivalent (IDE) scores will be calculated and a predicted in 

vivo class will be determined. 
3. Customized reports with calibration and dose-response curves may be printed. 

 
 

K. Clean Up: 
1. The Activator, Inhibition Check and all calibrators should be disposed of after the 

assay has been completed. See MSD Sheets for proper disposal procedures. 
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Figure 3.3. Plate Configuration – Alternative I 

Suitable Analysis for Four Samples at Five Volumes 
 
Figure Legend: 
 

 
 
 
   B 0:  1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 0:  1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 1:  1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to membrane disc. 
Cal 2:  1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to membrane disc. 
Cal 3:  1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to membrane disc. 
QC 1:  1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to membrane disc. 
QC 2:  1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to membrane disc. 

B:  1.25 ml Activated Blanking Buffer in well, 25, 50, 75, 100 and 125 µl/mg of sample  
applied to membrane discs. 

S:  1.25 ml Activated Reagent in well, 25, 50, 75, 100 and 125 µl/mg of sample applied to  
membrane discs. 

 
 
 
 
 
 
 

 
 

= well contains Blanking Buffer = well contains Reagent 
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Figure 3.4. Plate Configuration – Alternative II 

Suitable Analysis for Two Samples at Five Volumes in Duplicates 
 
Figure Legend: 
 

 
 
 
   B 0:  1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 0:  1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 1:  1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to membrane disc. 
Cal 2:  1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to membrane disc. 
Cal 3:  1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to membrane disc. 
QC 1:  1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to membrane disc. 
QC 2:  1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to membrane disc. 

B:  1.25 ml Activated Blanking Buffer in well, 25, 50, 75, 100 and 125 µl/mg of sample  
applied to membrane discs. 

S:  1.25 ml Activated Reagent in well, 25, 50, 75, 100 and 125 µl/mg of sample applied to  
membrane discs. 

 
 
 
 
 
 
 
 
 

= well contains Blanking Buffer = well contains Reagent 



IRRITECTION® ASSAY SSYTEM 
Instruction Manual 

CHAPTER 3
Experimental Protocols

 

©2002                                                   InVitro International                                                   16 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

DERMAL RESPONSE ASSAY 
VOLUME-DEPENDENT DOSE-RESPONSE PROTOCOL 

(HUMAN IRRITANCY EQUIVALENT SCORING SYSTEM) 
 
In Vitro International’s Dermal Response Assay is an in vitro assay method that may be 
employed to determine and predict the dermal irritation potential of non-surfactant based 
chemical, petrochemical, and cosmetic samples. The results of this test have been shown to 
correlate with those obtained with the in vivo human patch test. Dermal Response findings may 
be related to the in vivo test results through the Human Irritancy Equivalent (HIE) scoring system 
that has been developed for this purpose. 
 
This assay protocol provides a detailed description of the experimental procedures that are 
required to perform the Dermal Response Assay. The protocol consists of five steps: 
 

1. Preparation of the samples 
 
2. Preparation of the dermal protein reagent solution 

 
3. Set-up of the assay 

 
4. Incubation for 24 hours to permit reaction of the samples and protein reagent. 

 
5. Determination and interpretation of the assay results. 

 
The first three steps may be completed in approximately two hours. The final step, to be 
performed on the following day, may be completed in approximately one hour. 
 
Prior to beginning the assay, place the Hydrating Solution in a 25˚C incubator for 1 to 2 hours to 
ensure that it is approximately 25˚C. Remove the 24-well assay plates filled with membrane 
discs from the refrigerator. Allow the membrane discs to equilibrate to room temperature 
(approximately 30-45 minutes) before being used in Step III.D.3. 
 
I. Instrumentation, Reagents and Materials 

A. Kit Contains: 
15. Dermal Reagent Powder (1 Bottle) 
16. Dermal Hydrating solution (1 Bottle) 
17. Dermal Blanking Buffer (1 Bottle) 
18. Dermal Inhibition Check (1 Vial) 
19. Dermal Activator (1 Vial) 
20. Four Calibrator Solutions: Cal 0, Cal 1, Cal 2, Cal 3 
21. Two Quality Control Solutions: QC 1, QC 2 
22. 96-well Reading Plate (1) 
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23. 24-well Assay Plates Filled with Membrane Discs (26 pink discs and 22 clear 
discs)–store at 2-8˚C (2) 

24. Wooden Stirring Sticks (12) 
25. Whatman #1 Filter Paper, 12.5 cm diameter (1) 
26. Procedural Summary 
27. Range Specification Data Sheet 
28. Irritection Software Instructions 
 

B. Additional Materials Required: 
29. Plate Reader (such as Modified Cambridge 7520 Microplatereader) 
30. IBM compatible PC with Irritection Software 
31. Incubator Maintained at 25˚C ± 1˚C 
32. Balance (110 g Capacity) 
33. pH Meter 
34. Vortex Mixer 
35. Positive Displacement Micro Pipettor (such as Labindustries PopetteTM 

Micropipettor Model P-250, 0.5 – 250 µl) 
36. Multichannel Pipettor (such as Matrix 6 Channel EXP Impact Pipettor 15-1250 

µl) 
37. Disposable Reservoir Trays (2—such as 100 ml Matrix Disposable Reagent 

Reservoir) 
38. 100 ml Graduated Cylinder 
39. 100 ml Beaker 
40. Funnel (such as Oxford Vented Disposable Polystyrene Funnel, 12.5 cm 

diameter) 
41. Plastic Forceps 
42. Plastic Wrap 
 

II. Sample Preparation 
B. Sample Preparation 

 
Typically, five samples may be analyzed at four volumes (50, 75, 100, 125 µl). 

1. If the sample is a liquid, dilute the sample to the desired concentration for 
analysis. 

2. If the sample is a solid, attempt to convert in to a liquid by gently warming it. If 
the sample melts with warming, apply the liquid molten following procedures 
detailed in Step III.D.3. 

3. If the sample is a solid that does not readily melt with warming, weigh out 50, 75, 
100, and 125 mg of each sample and place each amount directly into the 
membrane discs. (If you choose to evaluate 4 samples at 5 volumes, 25 mg should 
be used as the fifth weight for analysis.) This should be completed prior to 
rehydrating the Reagent as described in Section III.A below. 
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III. Procedures 
A. Dermal Reagent Preparation: 
 

1. Rehydration: 
a. Remove the Hydrating Solution from the 25˚C incubator. 
b. Using a funnel, pour the entire contects of the Hydrating Solution into 

the Reagent Powder bottle. 
c. Gently swirl until all of the Reagent Powder is dissolved. 
d. Let the dissolved Reagent stand at room temperature for approximately 

10 minutes before filtering. 
 

2. Filtration: 
a. Fold the filter paper and place in funnel. 
b. Pour all of the dissolved Reagent into the funnel and collect the filtrate 

in a graduated cylinder at atmospheric pressure (do not use a vacuum 
pump.). This will take approximately 10 minutes. 
Note: During the filtration process, label the 24-well assay plates 
(Step III.B). 

c. Pour 40 ml of the filtered Reagent into a 100 ml beaker. 
Note: The Reagent must be used within 30 minutes of rehydration. 
 

3. Activation: 
a. Record the initial pH and temperature of the filtered Reagent, verifying 

that it falls within the following specified ranges: pH: 9.79-10.49 and 
T: 23-25˚C. 

b. Using the positive displacement pipettor, slowly add 920 µl of the 
Activator to the filtered Reagent. Gently swirl to mix. 

c. Record the final pH of the Activated Reagent solution, verifying that it 
falls within the following specified range: pH: 7.48-8.36. Note: If the 
pH does not fall within the specified range, recalibrate the pH meter, 
gently swirl the Reagent and remeasure the pH. If the pH is still not 
within the specified range, contact your technical representative at 1-
800-2-INVITRO. 

d. Using the positive displacement pipettor, slowly add 690 µl of the 
Activator to the bottle of Blanking Buffer. Gently swirl to mix. 

e. It is not necessary to measure the pH or temperature of the Activated 
Blanking Buffer. 
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B. Labeling the 24-Well Assay Plates: 
 

1. Remove the membrane discs from the assay plates and place them in a container. 
These discs will be used in Step D.1 

2. Align the assay plates with the notched corners toward the left and label their lids. 
A typical plate configuration that has been employed to evaluate five different 
samples at four different volumes is shows in Figure 3.9 on the next page. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



IRRITECTION® ASSAY SSYTEM 
Instruction Manual 

CHAPTER 3
Experimental Protocols

 

©2002                                                   InVitro International                                                   20 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

 
Figure 3.5. Suggested Plate Configuration: Analysis of Five Samples at 

Four Volumes 
 
Figure Legend: 
 

 
 
 
   B 0:1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to clear membrane disc. 
Cal 0:1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to pink membrane disc. 
Cal 1:1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to pink membrane disc. 
Cal 2:1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to pink membrane disc. 
Cal 3:1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to pink membrane disc. 
QC 1:1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to pink membrane disc. 
QC 2:1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to pink membrane disc. 

B:1.25 ml Activated Blanking Buffer in well, 50, 75, 100 and 125 µl/mg of sample applied  
    to clear membrane discs. 
S:1.25 ml Activated Reagent in well, 50, 75, 100 and 125 µl/mg of sample applied to pink 
    membrane discs. 

 
Note: Alternative assay schemes are shown in Figure 3.7 and 3.8 on pages 26 and 27 of the  

this chapter. 
 

C. Addition of Reagent and Blanking Buffer to 24-Well Assay Plates: 
 

1. Remove the labeled lid on each assay plate and use the lid or Figure 1 as a 
reference when filling the wells. 

2. Set the multichannel pipettor at 1250 µl. 

= well contains Blanking Buffer 
and an clear disc 

= well contains Reagent and a 
pink disc 
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3. Pour the Activated Reagent into a disposable reservoir tray. 
4. Using the multichannel pipettor, add 1250 µl of the Activated Reagent to the 

following wells: Cal 0, Cal 1, Cal 2, Cal 3, QC 1, QC 2 and all wells designated 
for analysis of the samples (S). 

5. Pour the Activated Blanking Buffer into a disposable reservoir tray. 
6. Change pipette tips and add 1250 µl of the Blanking Buffer to the wells 

designated B 0 on both plates and all other wells designated as blanks (B). 
 

D. Addition of Calibrators, Quality Controls and Samples: 
 
Note: Avoid cross contamination among the separate Calibrator, Quality 
Control and sample wells by utilizing a clean pipette tip for each. 
 
1. Pipette 125 µl of Cal 0 into a clear membrane disc and insert it into the B 0 well. 

Repeat this procedure for the B 0 well of the second assay plate, 
2. Pipette 125 µl of Cal 0, Cal 1, Cal 2, Cal 3, QC 1 and QC 2 into pink membrane 

discs and insert them into the appropriate wells of the assay plates. 
3. If the sample is a liquid, pipette 50, 75, 100 and 125 µl of each test sample into 

the clear and pink membrane discs and insert them into the corresponding blank 
and test sample wells of the assay plates. (If you wish to evaluate 4 samples at 5 
volumes, 25 µl should be used as the fifth volume for analysis.) 

4. If the sample is a solid, insert the membrane discs which contain 50, 75, 100 and 
125 mg of each test sample into the corresponding blank and test sample wells of 
the plates. 

 
E. Incubation: 

 
1. To prevent evaporation of the samples from the membrane discs, tightly wrap the 

assay plate with plastic wrap. Place a lid on top of each wrapped plate. 
2. Record the technician’s name, date and time on the lids of the assay plates. 
3. Place the assay plates in an incubator maintained at 25˚C ± 1˚C for 24 hours (± 30 

minutes). 
 

F. Removing Membrane Discs: 
 
1. Remove the assay plates from the incubator. 
2. Remove the lids from the assay plates and save them. They will be used as a 

reference when transferring the Reagent and the Blanking Buffer to the clean 96-
well reading plate. 

3. Remove the plastic wrap from each assay plate. 
4. Remove each membrane disc individually with plastic forceps. 
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5. Check the membranes for damage. Verify that all membrane discs are intact. If 
membrane damage has occurred, it should be recorded. Data for this sample 
should be carefully evaluated. 

6. Using the wooden stirring sticks, scrape the Reagent wells to ensure that all of the 
precipitate is removed from the bottom of each well. Use one stirring stick for 
each sample, starting with lowest volume wells first, the progressing to wells of 
higher volume. Use a separate stirring stick for each calibrator well. The wells 
containing Blanking Buffer do not need to be scraped. 

7. Note any wells with reduced volume. Reduced cell well volumes may be 
indicative of hygroscopic effects or technical problems and should be recorded. 

 
G. Transferring 250 µl of Reagent and Blanking Buffer into the 96-well Reading Plate: 

 
1. Set the multichannel pipettor to 260 µl for dispensing. 

Note: 260 µl is used for filling to ensure that no air bubbles are dispensed.  
The remaining 10 µl must be purged prior to refilling the 
multichannel pipettor. 

2. Transfer 250 µl from each well of the 24-well assay plates to every other well of 
the 96-well reading plate by columns (see Figure 2, page 7). 

3. Change pipette tips and repeat this process for each column. 
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Figure 3.6. Transferring from 24-Well Assay Plates to 96-Well Reading Plate 

 
Figure Legend: 
 

 
 
 
 
 

= cell should be empty 

= cell should contain 250 µl of Reagent or Blanking Buffer from the 24-well assay 
plates 
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H. Reading Assay on Plate Reader (refer to the Irritection Software Instructions found in 
Chapter 7 for more details: 

 
1. To eliminate inaccurate readings produced by settling of the precipitated Reagent, 

the assay must be read immediately after transferring the Reagent to the reading 
plate. 

2. If you have the Irritection Software for DOS, follow the instructions listed in Step 
2a. If you have the Irritection Software for WindowsTM, follow the instructions 
listed in Step 2b. 

a. Irritection Software for DOS: 
(1) Ensure that the plate set up in the Irritection Software matches the 

configuration for the assay and that the Calibrator/Quality Control 
ranges in the software are updated with the current kit lot number. 

(2) Select New Assay Entry from the Assay menu to initiate plate 
reader. 

(3) Remove the reading plate lid, wipe the bottom of the plate with a 
Kimwipe to remove any moisture and insert the plate into the plate 
reader with the corner notches facing to the left. 

(4) Follow screen prompts to read and analyze data (read absorbance 
at 450 nm). 

(5) Upon completion of data entry, press F10 to process data. If an 
Inhibition Check needs to be performed, a screen prompt will 
display the appropriate wells that require inhibition check. 

 
b. Irritection Software for Windows: 

(1) From the Method menu, choose Select. 
(2) Select the appropriate assay method. 
(3) From the File menu, choose New. 
(4) Select Assay. 
(5) Select the appropriate protocol. 
(6) Select the appropriate plate layout. 
(7) A series of screens will be displayed. You will need to enter the 

appropriate assay, and sample information. 
(8) The plate reader will initialize. Remove the reading plate lid, wipe 

the bottom of the plate with a Kimwipe to remove any moisture 
and insert the plate into the plate reader with the corner notches 
facing to the left. Click Continue, or press ENTER. 

(9) After the data collection is completed, a dialog box will be 
displayed indicating if the assay was qualified or unqualified. Click 
OK to continue. 
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(10) If an Inhibition Check needs to be performed, a screen 
prompt will display the appropriate wells that require Inhibition 
Check. 

3. If an Inhibition Check is required, add 25 µl of Inhibition Check to the 
appropriate wells. 

4. Wait five minutes, then re-read. 
 
 

I. Irritection Software Qualification Checks: 
The Irritection software will perform the following qualification checks to ensure 
assay performance. 
1. Calibrator/Quality Control Check: Verifies that Calibrators/Quality Controls are 

within specified ranges. 
2. Net Optical Density Check: Verifies that Net OD (ODreagent – ODblank = ODNet) is 

> -15. 
3. Inhibition Check: Verifies that OD of Inhibition Check is greater than OD of Cal 

2. 
4. Dose Response Check: Verifies that sample dose response curve is an increasing 

or flat curve. 
 
 

J. Sample Results: 
1. Upon acceptance of all qualification checks, the Irritection Software will generate 

a qualified assay report. 
2. Human Irritancy Equivalent (HIE) scores will be calculated and a predicted in 

vivo class will be determined. 
3. Customized reports with calibration and dose-response curves may be printed. 

 
 

K. Clean Up: 
1. The Activator, Inhibition Check and all calibrators should be disposed of after the 

assay has been completed. See MSD Sheets for proper disposal procedures. 
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Figure 3.7. Plate Configuration – Alternative I 

Suitable for Four Samples at Five Volumes 
 
Figure Legend: 
 

 
 
 
   B 0:1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to clear membrane disc. 
Cal 0:1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to pink membrane disc. 
Cal 1:1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to pink membrane disc. 
Cal 2:1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to pink membrane disc. 
Cal 3:1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to pink membrane disc. 
QC 1:1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to pink membrane disc. 
QC 2:1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to pink membrane disc. 

B:1.25 ml Activated Blanking Buffer in well, 25, 50, 75, 100 and 125 µl/mg of sample  
applied to clear membrane discs. 

S:  1.25 ml Activated Reagent in well, 25, 50, 75, 100 and 125 µl/mg of sample applied to  
pink membrane discs. 

 
 
 
 
 
 
 

 
 

= well contains Blanking Buffer 
and a clear disc 

= well contains Reagent and a 
pink disc 
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Figure 3.8. Plate Configuration – Alternative II 

Suitable for Two Samples at Five Volumes in Duplicates 
 
Figure Legend: 
 

 
 
 
   B 0:1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to clear membrane disc. 
Cal 0:1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to pink membrane disc. 
Cal 1:1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to pink membrane disc. 
Cal 2:1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to pink membrane disc. 
Cal 3:1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to pink membrane disc. 
QC 1:1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to pink membrane disc. 
QC 2:1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to pink membrane disc. 

B:1.25 ml Activated Blanking Buffer in well, 25, 50, 75, 100 and 125 µl/mg of sample  
applied to clear membrane discs. 

S:1.25 ml Activated Reagent in well, 25, 50, 75, 100 and 125 µl/mg of sample applied to  
pink membrane discs. 

 
 
 
 
 
 
 
 
 

= well contains Blanking Buffer 
and a clear disc 

= well contains Reagent and a 
pink disc 



IRRITECTION® ASSAY SSYTEM 
Instruction Manual 

CHAPTER 3
Experimental Protocols

 

©2002                                                   InVitro International                                                   28 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

OCULAR RESPONSE ASSAY 
CONCENTRATION-DEPENDENT DOSE-RESPONSE PROTOCOL 

(DRAIZE EQUIVALENT SCORING SYSTEM) 
 
In Vitro International’s Ocular Response Assay is an in vitro assay method that may be 
employed to determine and predict the ocular irritation potential of surfactant and surfactant -
based samples. The results of this test have been shown to correlate with those obtained with the 
in vivo Draize test. Ocular Response findings may be related to the in vivo test results through the 
Irritection Draize Equivalent (IDE) scoring system that has been developed for this purpose. 
 
This assay protocol provides a detailed description of the experimental procedures that are 
required to perform the Ocular Response Assay. The protocol consists of five steps: 
 

1. Preparation of the samples 
 

2. Preparation of the Ocular protein reagent solution 
 

3. Set-up of the assay 
 

4. Incubation for 24 hours to permit reaction of the samples and protein reagent. 
 

5. Determination and interpretation of the assay results. 
 
The first three steps may be completed in approximately two hours. The final step, to be 
performed on the same day, may be completed in approximately one hour. 
 
Prior to beginning the assay, place the Hydrating Solution in a 25˚C incubator for 1 to 2 hours to 
ensure that it is approximately 25˚C. Remove the 24-well assay plates filled with membrane 
discs from the refrigerator. Allow the membrane discs to equilibrate to room temperature 
(approximately 30-45 minutes) before being used in Step III.D.3. 
 
I. Instrumentation, Reagents and Materials 

A. Kit Contains: 
1. Ocular Reagent Powder (1 Bottle) 
2. Ocular Hydrating solution (1 Bottle) 
3. Ocular Blanking Buffer (1 Bottle) 
4. Ocular Inhibition Check (1 Vial) 
5. Ocular Activator (1 Vial) 
6. Four Calibrator Solutions: Cal 0, Cal 1, Cal 2, Cal 3 
7. Two Quality Control Solutions: QC 1, QC 2 
8. 24-well Assay Plates Filled with Membrane Discs (48 clear discs)–store at 2-8˚C 

(2) 
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9. 96-well Reading Plate (1) 
10. Wooden Stirring Sticks (12) 
11. Whatman #1 Filter Paper, 12.5 cm diameter (1) 
12. Procedural Summary 
13. Range Specification Data Sheet 
14. Irritection Software Instructions 
 

B. Additional Materials Required: 
1. Plate Reader (such as Modified Cambridge 7520 Microplatereader) 
2. IBM compatible PC with Irritection Software 
3. Incubator Maintained at 25˚C ± 1˚C 
4. Balance (110 g Capacity) 
5. pH Meter 
6. Vortex Mixer 
7. Positive Displacement Micro Pipettor (such as Labindustries PopetteTM 

Micropipettor Model P-250, 5 – 250 µl) 
8. Multichannel Pipettor (such as Matrix 6 Channel EXP Impact Pipettor 15-1250 

µl) 
9. Disposable Reservoir Trays (2—such as 100 ml Matrix Disposable Reagent 

Reservoir) 
10. 100 ml Graduated Cylinder 
11. 100 ml Beaker 
12. Funnel (such as Oxford Vented Disposable Polystyrene Funnel, 12.5 cm 

diameter) 
13. Plastic Forceps 
14. Plastic Wrap 
 

II. Sample Preparation 
A. Concentration-Dependent Dose-Response Study: Solids 

 
Five solid samples may be evaluated at four different concentrations. Obtain fine shavings 
from different locations on a solid material, e.g., a bar of soap. 
 

1. Weigh out the required amount of sample and place it in a beaker of suitable size. 
2. Add the appropriate amount of distilled water to the beaker. 
3. Mix on a magnetic stir plate or use a vortex mixer to achieve dissolution of the 

solid. 
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A typical range of concentrations could be prepared according to the following scheme: 
 

Concentration (%) Sample Weight (g) Volume Water (ml) 
15 1.50 10.0 
8 0.80 10.0 
5 0.50 10.0 
2 0.20 10.0 
1 0.10 10.0 

 
B. Concentration-Dependent Dose-Response Study: Liquids 

 
Five liquid samples may be evaluated at four different concentrations.  

1. Dilute liquid samples to the desired concentrations using distilled water as the 
diluent. 

A typical range of concentrations could be prepared according to the following scheme: 
 

Concentration (%) Volume Neat Sample (ml) Volume Water (ml) 
50 0.50 0.50 
25 0.25 0.75 
10 0.10 0.90 
5 0.05 0.95 
1 0.01 0.99 

 
Note: Sample preparation should be completed prior to proceeding to Step III. 

 
 
III. Procedures 

A. Dermal Reagent Preparation: 
 

1. Rehydration: 
a. Remove the Hydrating Solution from the 25˚C incubator. 
b. Using a funnel, pour the entire contents of the Hydrating Solution into 

the Reagent Powder bottle. 
c. Gently swirl until all of the Reagent Powder is dissolved. 
d. Let the dissolved Reagent stand at room temperature for approximately 

10 minutes before filtering. 
 

2. Filtration: 
a. Fold the filter paper and place in funnel. 
b. Pour all of the dissolved Reagent into the funnel and collect the filtrate 

in a graduated cylinder at atmospheric pressure (do not use a vacuum 
pump.). This will take approximately 10 minutes. 
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Note: During the filtration process, label the 24-well assay plates 
(Step III.B). 

c. Pour 40 ml of the filtered Reagent into a 100 ml beaker. 
Note: The Reagent must be used within 30 minutes of rehydration. 
 

3. Activation: 
a. Record the initial pH and temperature of the filtered Reagent, verifying 

that it falls within the following specified ranges: pH: 7.91-8.19 and T: 
23-25˚C. 

b. Using the positive displacement pipettor, slowly add 2400 µl of the 
Activator to the filtered Reagent. Gently swirl to mix. 

c. Record the final pH of the Activated Reagent solution, verifying that it 
falls within the following specified range: pH: 5.80-5.98. Note: If the 
pH does not fall within the specified range, recalibrate the pH meter, 
gently swirl the Reagent and remeasure the pH. If the pH is still not 
within the specified range, contact your technical representative at 1-
800-2-INVITRO. 

d. Using the positive displacement pipettor, slowly add 1800 µl of the 
Activator to the bottle of Blanking Buffer. Gently swirl to mix. 

e. It is not necessary to measure the pH or temperature of the Activated 
Blanking Buffer. 

 
B. Labeling the 24-Well Assay Plates: 
 

1. Remove the membrane discs from the assay plates and place them in a container. 
These discs will be used in Step D.1 

2. Align the assay plates with the notched corners toward the left and label their lids. 
A typical plate configuration that has been employed to evaluate five different 
samples at four different volumes is shows in Figure 3.5. 
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Figure 3.9. Suggested Plate Configuration: Analysis of Five Samples at 

Four Different Concentrations 
 
Figure Legend: 
 

 
 
 
   B 0:  1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 0:  1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 1:  1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to membrane disc. 
Cal 2:  1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to membrane disc. 
Cal 3:  1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to membrane disc. 
QC 1:  1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to membrane disc. 
QC 2:  1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to membrane disc. 

B:  1.25 ml Activated Blanking Buffer in well, 125 µl of sample solution at concentrations 1,  
2, 3 and 4 applied to membrane discs. 

S:  1.25 ml Activated Reagent in well, 125 µl of sample solution at concentrations 1, 2, 3 and  
4 applied to membrane discs. 

 
 
Note: Alternative assay schemes are shown in Figure 3.11 and 3.12 on pages 38 and 39 of 
this chapter. 
 

C. Addition of Reagent and Blanking Buffer to 24-Well Assay Plates: 
 

1. Remove the labeled lid on each assay plate and use the lid or Figure 1 as a 
reference when filling the wells. 

= well contains Blanking Buffer = well contains Reagent 
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2. Set the multichannel pipettor at 1250 µl. 
3. Pour the Activated Reagent into a disposable reservoir tray. 
4. Using the multichannel pipettor, add 1250 µl of the Activated Reagent to the 

following wells: Cal 0, Cal 1, Cal 2, Cal 3, QC 1, QC 2 and all wells designated 
for analysis of the samples (S). 

5. Pour the Activated Blanking Buffer into a disposable reservoir tray. 
6. Change pipette tips and add 1250 µl of the Blanking Buffer to the wells 

designated B 0 on both plates and all other wells designated as blanks (B). 
 

D. Addition of Calibrators, Quality Controls and Samples: 
 
Note: Avoid cross contamination among the separate Calibrator, Quality 
Control and sample wells by utilizing a clean pipette tip for each. 
 
1. Pipette 125 µl of Cal 0 into a clear membrane disc and insert it into the B 0 well. 

Repeat this procedure for the B 0 well of the second assay plate, 
2. Pipette 125 µl of Cal 0, Cal 1, Cal 2, Cal 3, QC 1 and QC 2 into the membrane 

discs and insert them into the appropriate wells of the assay plates. 
3. Pipette 125 µl of each test sample concentration into the membrane discs and 

insert them into the corresponding blank and test sample wells of the assay plates. 
 

E. Incubation: 
 
1. Tightly wrap the assay plate with plastic wrap. Place a lid on top of each wrapped 

plate. 
2. Record the technician’s name, date and time on the lids of the assay plates. 
3. Place the assay plates in an incubator maintained at 25˚C ± 1˚C for 5 hours (± 10 

minutes). 
 

F. Removing Membrane Discs: 
 
1. Remove the assay plates from the incubator. 
2. Remove the lids from the assay plates and save them. They will be used as a 

reference when transferring the Reagent and the Blanking Buffer to the clean 96-
well reading plate. 

3. Carefully remove the plastic wrap from each assay plate and use the forceps to 
remove each disc. 

4. Check the membranes for damage. Verify that all membrane discs are intact. If 
membrane damage has occurred, it should be recorded. Data for this sample 
should be carefully evaluated. 

5. Using the wooden stirring sticks, scrape the Reagent wells to ensure that all of the 
precipitate is removed from the bottom of each well. Use one stirring stick for 
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each sample, starting with lowest volume wells first, the progressing to wells of 
higher volume. Use a separate stirring stick for each calibrator well. The wells 
containing Blanking Buffer do not need to be scraped. 

 
G. Transferring 250 µl of Reagent and Blanking Buffer into the 96-well Reading Plate: 

 
1. Set the multichannel pipettor to 260 µl for filling and 250 µl for dispensing. 

Note: 260 µl is used for filling to ensure that no air bubbles are dispensed.  
The remaining 10 µl must be purged prior to refilling the 
multichannel pipettor. 

2. Transfer 250 µl from each well of the 24-well assay plates to every other well of 
the 96-well reading plate by columns (see Figure 2, page 8). 

3. Change pipette tips and repeat this process for each column. 
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Figure 3.10. Transferring from 24-Well Assay Plates to 96-Well Reading Plate 

 
Figure Legend: 
 

 
 
 

= cell should be empty 

= cell should contain 250 µl of Reagent or Blanking Buffer from the 24-well assay 
plates 
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H. Reading Assay on Plate Reader (refer to the Irritection Software Instructions found in 

Chapter 7 for more details: 
 
1. To eliminate inaccurate readings produced by settling of the precipitated Reagent, 

the assay must be read immediately after transferring the Reagent to the reading 
plate. 

2. If you have the Irritection Software for DOS, follow the instructions listed in Step 
2a. If you have the Irritection Software for WindowsTM, follow the instructions 
listed in Step 2b. 

a. Irritection Software for DOS: 
(1) Ensure that the plate set up in the Irritection Software matches the 

configuration for the assay and that the Calibrator/Quality Control 
ranges in the software are updated with the current kit lot number. 

(2) Select New Assay Entry from the Assay menu to initiate plate 
reader. 

(3) Remove the reading plate lid, wipe the bottom of the plate with a 
Kimwipe to remove any moisture and insert the plate into the plate 
reader with the corner notches facing to the left. 

(4) Follow screen prompts to read and analyze data (read absorbance 
at 405 nm). 

(5) Upon completion of data entry, press F10 to process data. If an 
Inhibition Check needs to be performed, a screen prompt will 
display the appropriate wells that require inhibition check. 

 
b. Irritection Software for Windows: 

(1) From the Method menu, choose Select. 
(2) Select the appropriate assay method. 
(3) From the File menu, choose New. 
(4) Select Assay. 
(5) Select the appropriate protocol. 
(6) Select the appropriate plate layout. 
(7) A series of screens will be displayed. You will need to enter the 

appropriate assay, and sample information. 
(8) The plate reader will initialize. Remove the reading plate lid, wipe 

the bottom of the plate with a Kimwipe to remove any moisture 
and insert the plate into the plate reader with the corner notches 
facing to the left. Click Continue, or press ENTER. 

(9) After the data collection is completed, a dialog box will be 
displayed indicating if the assay was qualified or unqualified. Click 
OK to continue. 
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(10) If an Inhibition Check needs to be performed, a screen 
prompt will display the appropriate wells that require Inhibition 
Check. 

3. If an Inhibition Check is required, add 25 µl of Inhibition Check to the 
appropriate wells. 

4. Wait five minutes, then re-read. 
 
 

I. Irritection Software Qualification Checks: 
The Irritection software will perform the following qualification checks to ensure 
assay performance. 
1. Calibrator/Quality Control Check: Verifies that Calibrators/Quality Controls are 

within specified ranges. 
2. Net Optical Density Check: Verifies that Net OD (ODreagent – ODblank = ODNet) is 

> -15. 
3. Inhibition Check: Verifies that OD of Inhibition Check is greater than OD of Cal 

2. 
4. Concentration Curve Check: Verifies that sample concentration curve is a 

parabolic curve. 
5. Dose Response Check: Verifies that sample dose response curve is an increasing 

or flat curve. 
 
 

J. Sample Results: 
1. Upon acceptance of all qualification checks, the Irritection Software will generate 

a qualified assay report. 
2. Irritection Draize Equivalent (IDE) scores will be calculated and a predicted in 

vivo class will be determined. 
3. Customized reports with calibration and dose-response curves may be printed. 

 
 

K. Clean Up: 
1. The Activator, Inhibition Check and all calibrators should be disposed of after the 

assay has been completed. See MSD Sheets for proper disposal procedures. 
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Figure 3.11. Plate Configuration – Alternative I 

Suitable for Four Samples at Five Concentrations 
 
Figure Legend: 
 

 
 
 
   B 0:  1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 0:  1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 1:  1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to membrane disc. 
Cal 2:  1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to membrane disc. 
Cal 3:  1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to membrane disc. 
QC 1:  1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to membrane disc. 
QC 2:  1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to membrane disc. 

B:  1.25 ml Activated Blanking Buffer in well, 125 µl of sample at concentrations 1, 2, 3, 4  
and 5 applied to membrane discs. 

S:  1.25 ml Activated Reagent in well, 125 µl of sample at concentrations 1, 2, 3, 4 and 5  
applied to membrane discs. 
 

 
 
 
 
 
 
 

 
 

= well contains Blanking Buffer = well contains Reagent 
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Figure 3.12. Plate Configuration – Alternative II 

Suitable for Two Samples at Five Concentrations in Duplicates 
 
Figure Legend: 
 

 
 
 
   B 0:  1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 0:  1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to membrane disc. 
Cal 1:  1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to membrane disc. 
Cal 2:  1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to membrane disc. 
Cal 3:  1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to membrane disc. 
QC 1:  1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to membrane disc. 
QC 2:  1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to membrane disc. 

B:  1.25 ml Activated Blanking Buffer in well, 25 µl/mg of sample at concentrations 1, 2, 3,  
4 and 5 applied to membrane discs. 

S:  1.25 ml Activated Reagent in well, 125 µl of sample at concentrations 1, 2, 3, 4 and 5  
applied to membrane discs. 

 
 
 
 
 
 
 
 

= well contains Blanking Buffer = well contains Reagent 
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DERMAL RESPONSE ASSAY 

CONCENTRATION-DEPENDENT DOSE-RESPONSE PROTOCOL 
(HUMAN IRRITANCY EQUIVALENT SCORING SYSTEM) 

 
In Vitro International’s Dermal Response Assay is an in vitro assay method that may be 
employed to determine and predict the dermal irritation potential of surfactant and surfactant -
based samples. The results of this test have been shown to correlate with those obtained with the 
in vivo human patch test. Dermal Response findings may be related to the in vivo test results 
through the Human Irritancy Equivalent (HIE) scoring system that has been developed for this 
purpose. 
 
This assay protocol provides a detailed description of the experimental procedures that are 
required to perform the Dermal Response Assay. The protocol consists of five steps: 
 

1. Preparation of the samples 
 

2. Preparation of the dermal protein reagent solution 
 

3. Set-up of the assay 
 

4. Incubation for 24 hours to permit reaction of the samples and protein reagent. 
 

5. Determination and interpretation of the assay results. 
 
The first three steps may be completed in approximately two hours. The final step, to be 
performed on the following day, may be completed in approximately one hour. 
 
Prior to beginning the assay, place the Hydrating Solution in a 25˚C incubator for 1 to 2 hours to 
ensure that it is approximately 25˚C. Remove the 24-well assay plates filled with membrane 
discs from the refrigerator. Allow the membrane discs to equilibrate to room temperature 
(approximately 30-45 minutes) before being used in Step III.D.3. 
 
I. Instrumentation, Reagents and Materials 

A. Kit Contains: 
1. Dermal Reagent Powder (1 Bottle) 
2. Dermal Hydrating solution (1 Bottle) 
3. Dermal Blanking Buffer (1 Bottle) 
4. Dermal Inhibition Check (1 Vial) 
5. Dermal Activator (1 Vial) 
6. Four Calibrator Solutions: Cal 0, Cal 1, Cal 2, Cal 3 
7. Two Quality Control Solutions: QC 1, QC 2 
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8. 96-well Reading Plate (1) 
9. 24-well Assay Plates Filled with Membrane Discs (26 pink discs and 22 clear 

discs)–store at 2-8˚C (2) 
10. Wooden Stirring Sticks (12) 
11. Whatman #1 Filter Paper, 12.5 cm diameter (1) 
12. Procedural Summary 
13. Range Specification Data Sheet 
14. Irritection Software Instructions 
 

B. Additional Materials Required: 
1. Plate Reader (such as Modified Cambridge 7520 Microplatereader) 
2. IBM compatible PC with Irritection Software 
3. Incubator Maintained at 25˚C ± 1˚C 
4. Balance (110 g Capacity) 
5. pH Meter 
6. Vortex Mixer 
7. Positive Displacement Micro Pipettor (such as Labindustries PopetteTM 

Micropipettor Model P-250, 0.5 – 250 µl) 
8. Multichannel Pipettor (such as Matrix 6 Channel EXP Impact Pipettor 15-1250 

µl) 
9. Disposable Reservoir Trays (2) (such as 100 ml Matrix Disposable Reagent 

Reservoir) 
10. 100 ml Graduated Cylinder 
11. 100 ml Beaker 
12. Funnel (such as Oxford Vented Disposable Polystyrene Funnel, 12.5 cm 

diameter) 
13. Plastic Forceps 
14. Plastic Wrap 
 

II. Sample Preparation 
A. Sample Preparation: Solids 

 
Typically, five solid samples may be evaluated at four different concentrations. Obtain fine 
shavings from different locations on a solid material, e.g., a bar of soap. 
 

1. Weigh out the required amount of sample and place it in a beaker of suitable size. 
2. Add the appropriate amount of distilled water to the beaker. 
3. Mix on a magnetic stir plate or use a vortex mixer to achieve dissolution of the 

solid. 
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A typical range of concentrations could be prepared according to the following scheme: 
 

Concentration (%) Sample Weight (g) Volume Water (ml) 
15 1.50 10.0 
8 0.80 10.0 
5 0.50 10.0 
2 0.20 10.0 
1 0.10 10.0 

 
B. Sample Preparation: Liquids 

 
Typically, five liquid samples may be evaluated at four different concentrations.  

1. Dilute liquid samples to the desired concentrations using distilled water as the 
diluent. 

A typical range of concentrations could be prepared according to the following scheme: 
 

Concentration (%) Volume Neat Sample (ml) Volume Water (ml) 
50 0.50 0.50 
25 0.25 0.75 
10 0.10 0.90 
5 0.05 0.95 
1 0.01 0.99 

 
Note: Sample preparation should be completed prior to proceeding to Step III. 

 
 
III. Procedures 

A. Dermal Reagent Preparation: 
 

1. Rehydration: 
a. Remove the Hydrating Solution from the 25˚C incubator. 
b. Using a funnel, pour the entire contents of the Hydrating Solution into 

the Reagent Powder bottle. 
c. Gently swirl until all of the Reagent Powder is dissolved. 
d. Let the dissolved Reagent stand at room temperature for approximately 

10 minutes before filtering. 
 

2. Filtration: 
a. Fold the filter paper and place in funnel. 



IRRITECTION® ASSAY SSYTEM 
Instruction Manual 

CHAPTER 3
Experimental Protocols

 

©2002                                                   InVitro International                                                   43 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

b. Pour all of the dissolved Reagent into the funnel and collect the filtrate 
in a graduated cylinder at atmospheric pressure (do not use a vacuum 
pump.). This will take approximately 10 minutes. 
Note: During the filtration process, label the 24-well assay plates 
(Step III.B). 

c. Pour 40 ml of the filtered Reagent into a 100 ml beaker. 
Note: The Reagent must be used within 30 minutes of rehydration. 
 

3. Activation: 
a. Record the initial pH and temperature of the filtered Reagent, verifying 

that it falls within the following specified ranges: pH: 9.79-10.49 and 
T: 23-25˚C. 

b. Using the positive displacement pipettor, slowly add 920 µl of the 
Activator to the filtered Reagent. Gently swirl to mix. 

c. Record the final pH of the Activated Reagent solution, verifying that it 
falls within the following specified range: pH: 7.48-8.36. Note: If the 
pH does not fall within the specified range, recalibrate the pH meter, 
gently swirl the Reagent and remeasure the pH. If the pH is still not 
within the specified range, contact your technical representative at 1-
800-2-INVITRO. 

d. Using the positive displacement pipettor, slowly add 690 µl of the 
Activator to the bottle of Blanking Buffer. Gently swirl to mix. 

e. It is not necessary to measure the pH or temperature of the Activated 
Blanking Buffer. 

 
B. Labeling the 24-Well Assay Plates: 
 

1. Align the assay plates with the notched corners toward the left and label their lids. 
A typical plate configuration that has been employed to evaluate five different 
samples at four different concentrations is shows in Figure 3.13 on the next page. 
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Figure 3.13. Suggested Plate Configuration: Analysis of Five Samples at Four Different 

Concentrations 
 
Figure Legend: 
 

 
 
 
B 0:  1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to clear membrane disc. 
Cal 0:  1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to pink membrane disc. 
Cal 1:  1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to pink membrane disc. 
Cal 2:  1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to pink membrane disc. 
Cal 3:  1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to pink membrane disc. 
QC 1:  1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to pink membrane disc. 
QC 2:  1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to pink membrane disc. 

B:  1.25 ml Activated Blanking Buffer in well, 125 µl/mg of sample solution (at  
concentrations 1, 2, 3 and 4 respectively) applied to clear membrane discs. 

S:  1.25 ml Activated Reagent in well, 125 µl/mg of sample solution (at  
concentrations 1, 2, 3 and 4 respectively) applied to pink membrane discs. 

 
Note: Alternative assay schemes are shown in Figure 3.15 and 3.16 on pages 50 and 51 of 
this chapter. 
 

C. Addition of Reagent and Blanking Buffer to 24-Well Assay Plates: 
 

1. Remove the labeled lid on each assay plate and use the lid or Figure 1 as a 
reference when filling the wells. 

2. Set the multichannel pipettor at 1250 µl. 
3. Pour the Activated Reagent into a disposable reservoir tray. 

= well contains Blanking Buffer 
and a clear disc 

= well contains Reagent and a 
pink disc 
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4. Using the multichannel pipettor, add 1250 µl of the Activated Reagent to the 
following wells: Cal 0, Cal 1, Cal 2, Cal 3, QC 1, QC 2 and all wells designated 
for analysis of the sample (S). 

5. Pour the Activated Blanking Buffer into a disposable reservoir tray. 
6. Change pipette tips and add 1250 µl of the Blanking Buffer to the wells 

designated B 0 on both plates and all other wells designated as blanks (B). 
 

D. Addition of Calibrators, Quality Controls and Samples: 
 
Note: Avoid cross contamination among the separate Calibrator, Quality 
Control and sample wells by utilizing a clean pipette tip for each. 
 
1. Pipette 125 µl of Cal 0 into a clear membrane disc and insert it into the B 0 well. 

Repeat this procedure for the B 0 well of the second assay plate, 
2. Pipette 125 µl of Cal 0, Cal 1, Cal 2, Cal 3, QC 1 and QC 2 into pink membrane 

discs and insert them into the appropriate wells of the assay plates. 
3. Pipette 125 µl of each test sample concentration into the clear and pink membrane 

discs and insert them into the corresponding blank and test sample wells of the 
assay plates. 

 
E. Incubation: 

 
1. To prevent evaporation of the sample from the membrane discs, tightly wrap the 

assay plate with plastic wrap. Place a lid on top of each wrapped plate. 
2. Record the technician’s name, date and time on the lids of the assay plates. 
3. Place the assay plates in an incubator maintained at 25˚C ± 1˚C for 24 hours (± 30 

minutes). 
 

F. Removing Membrane Discs: 
 
1. Remove the assay plates from the incubator. 
2. Remove the lids from the assay plates and save them. They will be used as a 

reference when transferring the Reagent and the Blanking Buffer to the clean 96-
well reading plate. 

3. Remove the plastic wrap from each assay plate. 
4. Remove each membrane disc individually with a plastic forceps. 
5. Check the membranes for damage. Verify that all membrane discs are intact. If 

membrane damage has occurred, it should be recorded. Data for this sample 
should be carefully evaluated. 

6. Using the wooden stirring sticks, scrape the Reagent wells to ensure that all of the 
precipitate is removed from the bottom of each well. Use one stirring stick for 
each sample, starting with lowest volume wells first, the progressing to wells of 
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higher volume. Use a separate stirring stick for each calibrator well. The wells 
containing Blanking Buffer do not need to be scraped. 

7. Note any wells with reduced volume. Reduced cell well volumes may be 
indicative of hygroscopic effects or technical problems and should be recorded. 

 
G. Transferring 250 µl of Reagent and Blanking Buffer into the 96-well Reading Plate: 

 
1. Set the multichannel pipettor to 260 µl for filling and 250 µl for dispensing. 

Note: 260 µl is used for filling to ensure that no air bubbles are dispensed.  
The remaining 10 µl must be purged prior to refilling the 
multichannel pipettor. 

2. Transfer 250 µl from each well of the 24-well assay plates to every other well of 
the 96-well reading plate by columns (see Figure 2, page 8). 

3. Change pipette tips and repeat this process for each column. 
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Figure 3.14. Transferring from 24-Well Assay Plates to 96-Well Reading Plate 

 
Figure Legend: 
 

 
 
 
 
 

= cell should be empty 

= cell should contain 250 µl of Reagent or Blanking Buffer from the 24-well assay 
plates 
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H. Reading Assay on Plate Reader (refer to the Irritection Software Instructions found in 
Chapter 7 for more details: 

 
1. To eliminate inaccurate readings produced by settling of the precipitated Reagent, 

the assay must be read immediately after transferring the Reagent to the reading 
plate. 

2. If you have the Irritection Software for DOS, follow the instructions listed in Step 
2a. If you have the Irritection Software for WindowsTM, follow the instructions 
listed in Step 2b. 

a. Irritection Software for DOS: 
(1) Ensure that the plate set up in the Irritection Software matches the 

configuration for the assay and that the Calibrator/Quality Control 
ranges in the software are updated with the current kit lot number. 

(2) Select New Assay Entry from the Assay menu to initiate plate 
reader. 

(3) Remove the reading plate lid, wipe the bottom of the plate with a 
Kimwipe to remove any moisture and insert the plate into the plate 
reader with the corner notches facing to the left. 

(4) Follow screen prompts to read and analyze data (read absorbance 
at 450 nm). 

(5) Upon completion of data entry, press F10 to process data. If an 
Inhibition Check needs to be performed, a screen prompt will 
display the appropriate wells that require inhibition check. 

 
b. Irritection Software for Windows: 

(1) From the Method menu, choose Select. 
(2) Select the appropriate assay method. 
(3) From the File menu, choose New. 
(4) Select Assay. 
(5) Select the appropriate protocol. 
(6) Select the appropriate plate layout. 
(7) A series of screens will be displayed. You will need to enter the 

appropriate assay, and sample information. 
(8) The plate reader will initialize. Remove the reading plate lid, wipe 

the bottom of the plate with a Kimwipe to remove any moisture 
and insert the plate into the plate reader with the corner notches 
facing to the left. Click Continue, or press ENTER. 

(9) After the data collection is completed, a dialog box will be 
displayed indicating if the assay was qualified or unqualified. Click 
OK to continue. 
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(10) If an Inhibition Check needs to be performed, a screen 
prompt will display the appropriate wells that require Inhibition 
Check. 

3. If an Inhibition Check is required, add 25 µl of Inhibition Check to the 
appropriate wells. 

4. Wait five minutes, then re-read. 
 
 

I. Irritection Software Qualification Checks: 
The Irritection software will perform the following qualification checks to ensure 
assay performance. 
1. Calibrator/Quality Control Check: Verifies that Calibrators/Quality Controls are 

within specified ranges. 
2. Net Optical Density Check: Verifies that Net OD (ODreagent – ODblank = ODNet) is 

> -15. 
3. Inhibition Check: Verifies that OD of Inhibition Check is greater than OD of Cal 

2. 
4. Concentration Curve Check: Verifies that sample concentration curve is a 

parabolic curve. 
 

J. Sample Results: 
1. Upon acceptance of all qualification checks, the Irritection Software will generate 

a qualified assay report. 
2. Human Irritancy Equivalent (HIE) scores will be calculated and a predicted in 

vivo class will be determined. 
3. Customized reports with calibration and dose-response curves may be printed. 

 
 

K. Clean Up: 
1. The Activator, Inhibition Check and all calibrators should be disposed of after the 

assay has been completed. See MSD Sheets for proper disposal procedures. 
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Figure 3.15. Plate Configuration – Alternative I 

Suitable for Four Samples at Five Concentrations 
 
Figure Legend: 
 

 
 
 
B 0:  1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to clear membrane disc. 
Cal 0:  1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to pink membrane disc. 
Cal 1:  1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to pink membrane disc. 
Cal 2:  1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to pink membrane disc. 
Cal 3:  1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to pink membrane disc. 
QC 1:  1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to pink membrane disc. 
QC 2:  1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to pink membrane disc. 

B:  1.25 ml Activated Blanking Buffer in well, 125 µl of sample (at concentration 1, 2, 3, 4  
and 5, respectively) applied to clear membrane disc. 

S:  1.25 ml Activated Reagent in well, 125 µl of sample (at concentration 1, 2, 3, 4  
and 5, respectively)applied to pink membrane disc. 

 
 
 
 
 
 
 

 
 

= well contains Blanking Buffer 
and a clear disc 

= well contains Reagent and a 
pink disc 
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Figure 3.16. Plate Configuration – Alternative II 

Suitable for Two Samples at Five Concentrations in Duplicates 
 
Figure Legend: 
 

 
 
 
B 0:  1.25 ml Activated Blanking Buffer in well, 125 µl of Cal 0 applied to clear membrane disc. 
Cal 0:  1.25 ml Activated Reagent in well, 125 µl of Cal 0 applied to pink membrane disc. 
Cal 1:  1.25 ml Activated Reagent in well, 125 µl of Cal 1 applied to pink membrane disc. 
Cal 2:  1.25 ml Activated Reagent in well, 125 µl of Cal 2 applied to pink membrane disc. 
Cal 3:  1.25 ml Activated Reagent in well, 125 µl of Cal 3 applied to pink membrane disc. 
QC 1:  1.25 ml Activated Reagent in well, 125 µl of QC 1 applied to pink membrane disc. 
QC 2:  1.25 ml Activated Reagent in well, 125 µl of QC 2 applied to pink membrane disc. 

B:  1.25 ml Activated Blanking Buffer in well, 25 µl of sample (at concentrations 1, 2, 3,  
4 and 5, respectively) applied to membrane discs. 

S:  1.25 ml Activated Reagent in well, 125 µl of sample (at concentrations 1, 2, 3, 4 and 5,  
respectively) applied to pink membrane discs. 
 
 
 
 
 
 
 
 
 

= well contains Blanking Buffer 
and a clear disc 

= well contains Reagent and a 
pink disc 
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The initial evaluation of the performance of the Irritection Assay system was conducted by 
performing a series of studies with defined irritants. Both Ocular and Dermal assays were 
assessed in this fashion. In each case, as noted in the legends, volume-dependent dose-response 
studies were performed. The results of these studies are summarized in Table 4.1 and figure 4.1 – 
4.3 found on the following pages. 
 
These investigations revealed at least tow important phenomena. First, it was noted that, as a 
general rule, the maximal IDE or HIE score was observed when the maximal volume (125 µl) of 
irritant was applied to the sample delivery membrane disc. This IDE/HIE value, termed the 
Maximum Qualified Score (MQS), serves as an important means of characterizing the irritancy 
potential of the test material. Methods of interpreting these types of dose-response curves, and 
defining the resultant MQS are covered in greater detail in Chapter 5 of this manual. Second, the 
data clearly demonstrated that both the Ocular and Dermal assays were highly reproducible. For 
example, when assessed at the maximum volume applied, mild, moderate, and severe irritants 
typically displayed a 5 to 15% variation from their mean value. 
 
Taken together, these findings demonstrated that both the Ocular and Dermal Irritection assays 
could be employed to reliably define the irritancy potential of a wide variety of irritant materials. 
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Ocular Cosmetic Assay Results 
Minimal Irritant 

IDE Scores (N=13) 
Mild Irritant 

IDE Scores (N=13) 
Moderate Irritant 
IDE Scores (N=13) 

Severe Irritant 
IDE Scores (N=13) Volume 

Applied (µl) Mean ±SD ±%SD Mean ±SD ±%SD Mean ±SD ±%SD Mean ±SD ±%SD 
25 7.88 3.41 43.3 9.40 3.95 42.0 18.75 5.43 29.0 38.74 5.43 14.0 
50 5.94 1.18 19.9 11.68 4.02 34.4 24.82 3.87 15.6 50.29 1.28 2.5 
75 5.48 1.30 23.7 15.34 1.71 11.1 29.03 4.29 14.8 50.50 1.13 2.2 

100 5.54 0.63 11.4 17.04 0.95 5.6 32.40 3.58 11.0 50.92 0.23 0.5 
125 5.50 1.00 18.2 19.35 0.96 5.0 32.47 3.96 12.2 50.70 0.92 1.8 

Ocular Surfactant (5 Hour) Assay Results 
Minimal Irritant 

IDE Scores (N=13) 
Mild Irritant 

IDE Scores (N=13) 
Moderate Irritant 
IDE Scores (N=13) 

Severe Irritant 
IDE Scores (N=13) Volume 

Applied (µl) Mean ±SD ±%SD Mean ±SD ±%SD Mean ±SD ±%SD Mean ±SD ±%SD 
25 8.34 2.54 30.5 12.76 2.41 18.9 16.89 4.42 26.2 35.79 3.07 8.6 
50 5.36 1.84 34.3 13.71 1.58 11.5 19.79 4.55 23.0 47.88 3.24 6.8 
75 4.17 1.67 40.0 15.69 1.84 11.7 23.26 5.48 23.6 49.91 1.63 3.3 

100 4.08 1.90 46.6 17.69 2.07 11.7 25.45 4.71 18.5 50.11 1.42 2.8 
125 4.26 1.52 35.7 20.26 1.93 9.5 27.20 4.02 14.8 29.94 1.87 3.7 

Dermal Cosmetic Assay Results 
Minimal Irritant 

IDE Scores (N=13) 
Mild Irritant 

IDE Scores (N=13) 
Moderate Irritant 
IDE Scores (N=13) 

Severe Irritant 
IDE Scores (N=13) Volume 

Applied (µl) Mean ±SD ±%SD Mean ±SD ±%SD Mean ±SD ±%SD Mean ±SD ±%SD 
25 0.35 0.20 57.1 0.25 0.11 44.0 0.43 0.21 48.8 1.23 0.60 48.8 
50 0.21 0.15 71.4 0.30 0.10 33.3 0.63 0.32 50.8 3.02 0.80 26.5 
75 0.22 0.19 86.4 0.38 0.09 23.7 1.64 0.48 29.3 3.29 0.45 13.7 

100 0.18 0.12 66.7 0.44 0.09 20.5 2.17 0.44 20.3 3.52 0.60 17.0 
125 0.20 0.17 85.0 0.59 0.10 16.9 2.37 0.30 12.7 3.42 0.50 14.6 

Table 4.1. Variability of Ocular and Dermal Irritection Assay Results with Defined Irritants 
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Figure 4.1. Variability of Ocular Irritection Assay with Defined Irritants 
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Figure 4.2. Variability of Ocular Irritection Assay (5 Hour Surfactant Protocol) with Defined Irritants 
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Figure 4.3. Variability of Dermal Irritection Assay with Defined Irritants 
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Following completion of the internal evaluation of the Irritection Assay System, additional 
studies were performed by conducting a series of inter-laboratory comparative studies utilizing a 
set of reference chemicals. The primary objectives of these investigations were three-fold. First, 
to demonstrate that the Ocular Irritection assays were applicable over a broad range. Second, to 
confirm that the results obtained with the Irritection assays were similar to those obtained with 
the Eytex test (Chapter 2). Third, to define the inter-laboratory variability of the in vitro tests. 
 
The results of these investigations are summarized in Table 4.2 on the next page. These findings 
may be briefly summarized as follows: 
 

• The Ocular Irritection assays detect and distinguish the irritancy of chemicals whose in 
vivo classification ranged from minimal to severe. 

 
• The Irritection and Eytex assays provided comparable results as judged by both their 

equivalence score (95%) and the correlation coefficient calculated by linear regression 
analysis (mean r = 0.98). 

 
• The Irritection test was found to display a somewhat better correlation with the results of 

the Draize test (equivalence = 87.5%) than the Eytex test did (equivalence = 81.3%). 
 

• The inter-laboratory variance for the Irritection test was quite acceptable, being 
calculated to be 13.9% of the mean for this group of reference chemicals. 

 
Taken together, these observations confirm that the Ocular Irritection Assays provide results that 
correlate closely with those obtained in vivo and are somewhat more reliable than those provided 
by the earlier Eytex test. 
 
These initial findings were subsequently confirmed and extended in a second study that was 
performed with a much larger group of chemicals. The results of this investigation are 
summarized in Table 4.3. The 2X2 contingency table presented here summarizes the frequency 
of observations of agreement and disagreement between the Ocular Irritection test method and 
the Draize test method and permits calculation of the following comparative parameters: 

• Equivalence of Irritection and Draize Assays = 83.0% 
• Sensitivity (Irritection Method Correctly Identifies Irritants) = 86.4% 
• Specificity (Irritection Method Correctly Identifies Non-Irritants) = 93.5% 
• Predictive Value (Irritection Method Correctly Predicts Irritancy) = 90.5% 

 
  Draize Method 

  Non-Irritants Irritants 
Irritection Non-Irritants 29 3 

Method Irritants 2 19 
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Irritection® Data Eytex® Data Sample A B C D Mean Class A B C D Mean Class 
In Vivo 

Classification 
0.1% SDC 23.1 24.1 23.7 17.6 22.1 Mild/Mod 19.4 16.6 13.7 16.4 16.5 Min/Mild  
1% BAS 38.2 36.6 42.9 36.3 38.5 Severe 42.6 >51 39.2 38.8 40.2 Sever Severe 

1% Acetic Acid 29.7 27.3 24.7 26.1 27.0 Mod 22.9 22.8 25.3 23.9 23.7 Mild/Mod  
10% Acetic Acid 46.9 47.5 48.6 49.3 48.1 Sev/Extr 47.1 49.0  46.1 47.4 Sev/Extr Severe 
Ethylene Glycol 4.4 NQ 1.9 3.9 3.4 Min 5.1 NQ 4.2 NQ 4.7 Min Min 
Propylene Glycol 7.4 7.7 4.3 7.0 6.6 Min 8.8 8.3 7.1 5.7 7.5 Min Min 

NaC1 14.4 22.5 14.2 18.5 17.4 Min/Mild 14.4 14.7  15.6 14.9 Min Mild 
Methanol 22.8 26.4 21.4 20.5 22.8 Mild/Mod 25.0 18.4 25.8 26.6 24.0 Mild/Mod Mild/Mod 
Triacetin 30.4 31.8 28.1 28.4 29.7 Mod 30.3 25.3 27.9 25.0 27.1 Mod Min 

n-Propanol 35.0 32.8 33.8 31.3 33.2 Mod/Sev 37.0 32.2  29.7 33.0 Mod/Sev Mod 
 

Inter-Laboratory Correlations 
Laboratory Irritection® : Eytex® (r) Irritection® : Irritection®  (r) Eytex® : Eytex® (r) 

A 0.97   
B 0.95   
C 0.94   
D 0.97   

Mean Four Laboratories 0.98   
A:B  0.96 0.97 
A:C  0.99 0.98 
A:D  0.98 0.97 

 
Equivalence Scores 

Irritection®: In Vivo = 87.5% Irritection® : Eytex® = 95% Eytex®: In Vivo = 81.3% 
 

Table 4.2 Comparison of Ocular Irritection®, Eytex® and In Vivo Measures of Irritancy 
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Chemical Irritection 
Classification 

In vivo 
Classification Equivalence Irritection 

Score > 25 
In Vivo 

>Mild/Mod Equivalence 

1-Butanol Mod/Sev Sev/Ext 1 + + + 
2,4-Dichlorophenoxyacetic Acid Mod/Sev Sev/Ext 1 + + + 

2,5-Hexanediol Mild Min 0.5 - - - 
2-Butoxyethyl Acetate Min Min/Mild 1 - - - 

2-Methoxyethanol Mild Min 0.5 - - - 
Acetic Acid, 10% Mod/Sev Sev/Ext 1 + + + 

Acetonitrile Mild Mod 0.5 + + + 
Acrolein Mild Sev/Ext 0 - + 0 

Acrylamide Mild/Mod Mod 1 + + + 
Acrylonitrile Mild Mild 1 - - - 

Aniline Mod/Sev Mod 1 + + + 
Benzalkonium Chloride, 10% Mod/Sev Sev/Ext 1 + + + 
Benzalkonium Chloride, 10% Mild/Mod Sev/Ext 0.5 + + + 

Betaine Min/Mild Mild 1 - - - 
Boric Acid, 1% Min/Mild Mild/Mod 1 - - - 

Brij 35 Min Min 1 - - - 
CHAPSO, 1% Mild Min 0.5 - - - 

Chloramphenicol, 1% Min Min 1 - - - 
Chloroform Mild Mod 0.5 - + 0 

Chlorpromazine HCI, 1% Mild/Mod Mod 1 + + + 
Citric Acid Mod/Sev Sev/Ext 1 + + + 

Crystal Violet, 10% Mild/Mod Mod/Sev 0.5 + + + 
Cycloheximide Mild MinMild 1 - - - 

Dibutyltin Dichloride Mod/Sev Mod/Sev 1 + + + 
DMSO Mild Min 0.5 - - - 

Table 4.3. Summary of Ocular Irritection® Assay System Results 
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Chemical Irritection 
Classification 

In vivo 
Classification Equivalence Irritection 

Score > 25 
In Vivo 

>Mild/Mod Equivalence 

EDTA Mod/Sev Sev/Ext 1 + + + 
Ethanol Mild Mild/Mod 1 - - - 

Ethylene Glycol Min Min 1 - - - 
Fluorescein, 10% Min/Mild Mild 1 - - - 

Glycerol Min Min 1 - - - 
Hexane Mild Min 0.5 - - - 
Menthol Min/Mild Sev/Ext 0 - + 0 

Propylene Glycol Min Min 1 - - - 
Silver Nitate, 5% Min/Mild Min 1 - - - 

Sodium Chloride, 0.9% Mild Mild 1 - - - 
Sodium Dodecyl Sulfate, 30% Mild/Mod Mod 1 + + + 

Sodium Hydroxide, 10% Mild/Mod Mod/Sev 0 + + + 
Sodium Stearate Min Min 1 - - - 

Squalene Min Min 1 - - - 
Strearic Acid Min Min 1 - - - 

Talc Min/Mild Min 1 - - - 
Toluene Mild Mild 1 - - - 
Triacetin Mild Min 0.5 + - 0 

Tributyltin Chloride Mod Sev/Ext 0.5 + + + 
Triethanol Amine Mod Mild/Mod 1 + - 0 

Triton X-100 Min/Mild Min 1 - - - 
Tween 80, 10% Min/Mild Min 1 - - - 

Table 4.3 (Continued) 
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As noted previously, surfactants and surfactant-containing compounds exhibit a unique behavior 
when analyzed in the Irritection Assay System. Consequently, they are most accurately 
characterized by utilizing them to perform concentration-dependent studies. This observation has 
been confirmed by conducting these types of investigations with a representative sample of 
commonly used surfactants. The results of these studies are summarized in Table 4.4 and Figure 
4.4 shown on the next page. 
 

Surfactant Type Sample 
Number 

Draize 
Score 

Irritection Assay 
Scorea,b 

Amphoteric 29 20.7 13.1 
Amphoteric 35 5.3 18.6 
Amphoteric 79 4.0 16.2 

Anionic 27 34.3 36.9 
Anionic 36 33.0 38.1 
Cationic 25 0.67 10.5 
Cationic 30 14.0 11.1 
Cationic 31 3.3 11.8 
Blends 44 12.0 17.9 
Blends 46 18.0 17.3 
Blends 69 18.0 17.3 

 

Correlation: Vs Draize R = 0.82 
y = 0.68x + 8.8 

 
 

Table 4.4. Summary of Irritection Results Obtained with Surfactants 
 

 
a Score = Maximal Score Observed with Qualified Dose-Response Curve 
 
b Concentration-Dependent Assays Performed by Applying 125 µl of Surfactant; Concentrations 
Tested: 0.1, 0.3, 1.0, 3.0, and 10% (v/v). 
 
 
These studies demonstrate two important findings. First, as indicated by the calculated 
correlation coefficient of 0.80, the irritancy scores determined with the Irritection method are 
highly correlated with those determined in vivo. Second, this correlation is true for a wide variety 
of surfactants, with the exception that the Irritection method appears to over estimate the 
irritancy of nonionic surfactants. 
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Figure 4.4. Comparison of Irritection Assay Scores and Draize Scores 
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The accuracy and reproducibility of the Dermal version of the Irritection Assay System has been 
evaluated in a blinded study of eight liquid dishwashing detergents whose dermal irritancy 
properties had previously been defined by accepted human dermal patch testing methods. These 
investigations also compared results obtained with the Irritection test method to those obtained 
with the earlier Skintex test. 
 
The Dermal Irritection assay was performed on four separate occasions by three different 
laboratory scientists in order to both characterize the samples and provide a mean of accessing 
the reproducibility of this particular assay method. The results of these studies are summarized in 
Figure 4.5 below. 

 
Figure 4.5. Dermal Irritection Assay Results Obtained for 10% Solutions of Liquid 

Dishwashing Detergents. Results are Expressed as Mean Value ± Standard Deviation. 
 
These findings demonstrate the two of the formulations would be predicted to be irritant and the 
remaining six would be considered to be non-irritating. Further, these investigations 
demonstrated that the Dermal Irritection test was highly reproducible, with irritant detergents 
displaying irritancy scores whose standard deviation was only 3% of the mean score value. Of 
equal importance, the Dermal Irritection test method accurately predicted the dermal irritancy of 
all eight detergents when the in vitro  test scores were compared to the in vivo  findings. The 
Skintex test method was also found to be capable of discriminating irritant from non-irritant 
detergents. However, the results of the Skintex tests and in vivo tests were concordant for only 
seven of the eight detergents evaluated. These findings indicate that the Dermal Irritection test is 
an accurate and reproducible in vitro method of predicting the dermal irritancy potential of liquid 
detergents. As such, it may be successfully employed as a rapid screening tool to facilitate new 
product development and formulation activities.
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The windowsTM software provided with the Irritection Assay System performs four important 
functions. They are as follows: 
 

• Compilation of the spectrophotometric reading obtained at the completion of the assay 
procedure, 

 
• Comparison of the results obtained with the test samples to those obtained with a series 

of calibration (Cal) and quality control (QC) standards, 
 

• Calculation of the irritancy scores for each test material, and 
 

• Presentation of the assay information in tabular and graphic form in a four-page print out. 
 
 
In general, the computer program print out provides a clear interpretation of the experimental 
results. The Sample Results section of the report lists the optical density data, calculated 
irritancy scores, and irritancy classifications based on the correlative information summarized in 
Tables 5.1 and 5.2 below. 
 

Irritection Draize Equivalent (IDE) Predicted Ocular Irritancy Classification 

0.0 – 12.5 Minimal Irritant 
12.5 – 30.0 Mild Irritant 
30.0 – 51.0 Moderate Irritant 
51.0 – 80.0 Severe Irritant 

 
Table 5.1 Relationship of Irritection Draize Equivalent (IDE) Score to Irritancy 

Classification for the Ocular Irritection Test Method 
 
 

Human Irritancy Equivalent (HIE) Predicted Dermal Irritancy Classification 

0.00 – 0.90 Non-Irritant 
0.90 – 1.20 Non-Irritant/Irritant 
1.20 – 5.00 Irritant 

 
Table 5.2 Relationship of Human Irritancy Equivalent (HIE) Score to Irritancy 

Classification for the Dermal Irritection Test Method 
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Prior investigations have demonstrated that the irritancy score (Ocular Irritection Draize 
Equivalent [IDE] or Dermal Human Irritancy Equivalent [HIE]) that correlates most closely with 
the in vivo irritancy properties of a test material is the highest qualified score calculated by the 
Irritection software. In the discussion that follows, this value has been defined as the Maximum 
Qualified Score (MQS). Examples of test results with the MQS denoted in each case are included 
in Figure 5.1 to 5.4. 
 
The Sample Results section of the assay report also contains a statement about the 
“Qualification” of the test material at each tested volume or concentration. In most cases, this 
column of the report will contain a series of statements indicating that each sample tested was 
“Qualified”. This statement simply means that the computer software has utilized an internal 
algorithm to analyze the data for each dose tested and found that the results obey the expected 
behavior of typical dose-repose curve. 
 
Occasionally, the Qualification section of the report will contain a statement directing the user to 
“Examine Dose Curve” or “Examine Concentration Curve.” These messages are printed when 
the computer algorithm detects an unexpected assay result. The primary purpose of these 
messages is to cause the user to examine the printed graph of the test results to determine the 
source of the unexpected behavior. 
 
In general, two phenomena have been identified as producing atypical dose-response profiles and 
serving as potential sources of these messages. Most commonly, the “Examine Dose Curve” 
message is printed when the volume-dependent dose-response protocol is employed and the 
tested material contains a surfactant which produces a declining, rather than increasing, dose-
response profile. The other common source of the “Examine Dose or Concentration Curve” 
message is an artifact that results in an unusually elevated value being detected. This type of 
artifact most commonly results from a pin-hole leak in the membrane delivery device or because 
the tested material was very hygroscopic. 
 
Additionally it should be noted that the “Examine Concentration Curve” message will not be 
printed if the concentration-dependent dose-response (surfactant) protocol is employed and the 
software’s curve fitting program is enabled. This results from the fact that the Irritection 
algorithm accommodates a declining dose-response profile when analyzing known surfactant. 
 
The following figures are provided as examples of typical volume-dependent and concentration-
dependent assay profiles. They should be employed to assist in the interpretation of common 
assay findings. 
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Figure 5.1 Examples of Typical Ocular Volume-Dependent Dose-Response Profiles 
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The Irritection software print out would report the test materials denoted by the symbols ( ), 
( ) and ( ) to be “Qualified." By contrast, the material designated by the symbol ( ) displays a 
decreasing dose-response profile and the Qualification message would read, “Examine Dose 
Curve.” 
 
Maximum Qualified Scores (MQS) are denoted in each case. 



IRRITECTION® ASSAY SYSTEM 

Instruction Manual 
CHAPTER 5

Interpretation of Data
 

©2002                                                  InVitro International                                                      6 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

 
Figure 5.2 Examples of Typical Ocular Concentration-Dependent Dose-Response Profiles 

 
The Irritection software print out would report the test materials denoted by the symbols ( ), 
( ) and ( ) to be “Qualified." Additionally, the surfactant designated by the symbol ( ), which 
displays a decreasing dose-response profile, would be reported as qualified, if the curve fitting 
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program had been enabled. If this software feature had not been enabled, the Qualification 
message would have read, “Examine Concentration Curve.” 
 
Maximum Qualified Scores (MQS) are denoted in each case. 
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Figure 5.3 Examples of Typical Ocular Concentration-Dependent Dose-Response Profiles 

 
The Irritection software print out would report a Qualification message reading, “Examine 
Concentration Curve” for all of the test materials. The material denoted by the symbol ( ) is a 
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surfactant that displays a dramatically decreasing dose-response profile. Additionally, this 
material would interfere with the inhibition check portion of the assay. Artifacts denote 
anomalously elevated IDE scores. 
 
Maximum Qualified Scores (MQS) are denoted in each case. 

 
Figure 5.4 Examples of Typical Dermal Concentration-Dependent Dose-Response Profiles 
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The Irritection software print out would report the test materials denoted by the symbols ( ), 
( ) and ( ) to be “Qualified," if the curve fitting program is enabled. By contrast, the curve 
containing the artifact in the profile denoted by the symbol ( ) would produce a Qualification 
message reading, “Examine Concentration Curve.” 
 
Maximum Qualified Scores (MQS) are denoted in each case. 
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Certain types of chemicals and chemical formulations are known to be incompatible with the 
protein reagents that are utilized in the Ocular and Dermal Irritection assays. These materials are 
described below in Table 6.1. 
 
 
Table 6.1 Materials that are Incompatible with The Irritection Assay System 
 

Chemical or Chemical 
Formulation 

Nature of 
Incompatibility 

Solution for Problem 

Acidic formulations, pH<2.0 False negative or precipitation Dilute or neutralize sample 
Alkaline formulations, pH>9.0 False negative Dilute or neutralize sample 
Intensely colored materials  High OD readings for blanks 

and samples 
Dilute sample or read OD at 
700 nm 

Oils and water-insoluble 
organic chemicals 

Oil droplets may produce 
erratic dose-response profiles 

 

Volatile ketones Evaporation results in an 
under-estimation of irritancy 

 

Nonionic Surfactants False positive over-estimates 
of irritancy 

 

Sorbitol at concentrations>5% False positive Dilute Sample 
Urea at concentrations>5% False negative Dilute Sample 
Manganese violet False positive Dilute Sample 
Aluminum chlorohydrate False positive Dilute Sample with propylene 

glycol 
Aluminum zirconium 
chlorohydrate 

False positive Dilute Sample with propylene 
glycol 

Aluminum chloride False positive Dilute Sample with propylene 
glycol 

Titanium oxide False positive Dilute Sample 
Zinc oxide False positive Dilute Sample 
Silver salts False positive Dilute Sample 
Ferrous sulfate False positive Dilute Sample 
Zink sulfate False positive Dilute Sample 
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IRRITERCTION® SOFTWARE INSTRUCTIONS 
FOR WINDOWS 

 
A. Installing the Irritection Software 

1. Insert the Irritection Software installation disk into the 3.5” disk drive. 
2. From the Program Manager, go to the File menu, and select Run. 
3. A Run dialog box will be displayed. Click on the Browse button. 
4. From the Driver box, click the 3.5” disk drive (a or b). From the File Name Box, click the 

setup.exe fine, then click the OK button. 
5. A Run dialog box will be displayed. Click the OK button. 
6. The Irritection Software Setup will begin initialization. Click on the Continue button. 
7. A Destination Path dialog box will be displayed. Click on the Continue button. 
8. After the software has been installed, a message will appear stating, “Setup Succeeded.” 

Click the OK button. 
Note: If the installation was not successful, please call your Technical 
Representative for assistance. 

 
B. Setting Up the Instrument 

1. Double-click on the Irritection Software icon to launch the program. 
2. From the Instrument menu, choose Setup. 

You will need to enter the following system parameters (this needs to only be done once): 
 
Comm Port: 
Select the appropriate Comm Port. 
 
Filters (nm): 
The wavelength of each filter installed on the filter wheel of the plate reader will need to 
be entered in order for the program to choose the correct filter when reading. Enter zero 
to indicate an empty position. 
 
Serial Number: 
The serial number of the plate reader will need to be entered. 
Note: For the Cambridge plate reader, the serial number can be found inside the 
plate reader on the left corner panel. For the Molecular Devices or Dynatech plate 
reader, the serial number can be found on the rear panel. 
 
Instrument Type: 
Click the arrow in the Instrument Type box, and select the appropriate instrument type. 
Note: The Baud Rate, Data Bits, Parity, and Stop Bits will correctly default for each 
instrument type. The Plate Type will default on Generic 96-Well. 
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3. Click the OK button, or press ENTER. 
 
C. Selecting the Assay Method 

1. From the Method menu, choose Select. 
2. Select the desired assay method (Ocular, High Sensitivity Ocular, Dermal, or High 

Sensitivity Dermal), and click the OK button, or press ENTER. 
 
D. Reading a New Assay 

1. From the File menu, choose New. 
2. Select Assay, and click OK button or press ENTER. 
3. Select the desired protocol, and click the OK button or press ENTER. 
4. Select the desired plate layout, and click the OK button, or press ENTER. 
5. A series of screens will be displayed. You will need to enter the appropriate assay, and 

sample information. When you have finished, click the OK button. 
Note: The Sample Number for each sample must be entered. The Sample Number is 
used as the filename for the data file that will contain the results of the assay. 

6. The plate reader will initialize. Load the assay plate, and click on the Continue button or 
press ENTER. 

7. After the data collection has been completed, a dialog box will be displayed indicating if 
the assay was qualified or unqualified. Press the OK button to continue. If an “Inhibition 
Check” prompt does not appear, proceed to Step E to print the processed report. 

 
E. Performing an Inhibition Check 

1. If an inhibition check is required, a series of screens will appear indicating the specific 
well(s) on the assay plate that require an inhibition check. 

2. Add 25 µl of the inhibition check to the appropriate well(s). 
3. Wait 5 minutes, load the plate, then click the Continue button. 
4. A dialog box will indicate if the assay was qualified or unqualified. Remove the plate, 

and press the OK button to continue. 
 
F. Performing an Inhibition Check 

1. A window, which displays the processed assay section of the report, for each sample will 
be displayed. To open additional windows (such as the protocol, plate layout, calibration 
curve, response curve or plate data), go to the View menu, and choose the desired window 
to be viewed. 

2. To print the complete processed report, go to the File menu, and click the Print button. 
(The defaults have already been selected for you.) 

3. To print additional sections of the report, select the section, and click on the Print button. 
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IRRITECTION® SOFTWARE FOR WINDOWSTM 
DETAILED INSTRUCTIONS 

 
SECTION ONE: SETTING UP 
 
I. Introduction: 
Thank you for purchasing the Irritection® Software, a program designed to make your assay 
processing easier and more productive. 
 
Prior to using the Irritection Software, make sure your package contains the following items: 
 

1. InVitro International License Agreement (to be read carefully before proceeding). 
 
2. Irritection software User’s Manual for WindowsTM. 

 
3. Irritection Software Diskette. 

 
II. Installing the Software Program at a Working Station: 

1. It is recommended that you make a backup copy of the Irritection Software diskette using 
the DOS Diskcopy command. See your DOS manual for more information. 

 
2. Insert the backup copy of the software disk created in Step 1 into the 3.5” disk drive. 

 
3. From the Program Manager, go to the File menu, and select Run. 

 
4. A Run dialog box will be displayed. Click on Browse. 

 
5. From the Drives box, click the 3.5” disk drive (a or b). From the File Name Box, click 

Setup.exe, then click OK. 
 

6. A Run dialog box will be displayed. Click OK. 
 

7. The Irritection Software Setup will begin initialization. Click Continue. 
 

8. A Destination Path dialog box will be displayed. Click Continue. 
 

9. After the Software has been installed, a message will appearing stating, “Setup 
Succeeded.” Click OK. 

 
Note: If the installation was not successful, or if you would like to install the 
software on a network, please call your Technical Representative for assistance. 
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III. Setting Up Your Plate Reader: 
1. Double-click on the Irritection Software icon to launch the program. 
 
2. From the Instrument menu, choose Setup.  

You will need to enter the following system parameters (this needs to only be done once): 
 
Comm Port: 
Select the appropriate Comm Port. 
 
Filters (nm): 
The wavelength of each filter installed on the filter wheel of the plate reader will need to 
be entered in order for the program to choose the correct filter when reading. Enter zero 
to indicate an empty position. 
 
Serial Number: 
The serial number of the plate reader will need to be entered. 
 
Note: If you have the Cambridge plate reader, the serial number can be found 
inside the plate reader on the left corner panel. For the Molecular Devices or 
Dynatech plate reader, the serial number can be found on the rear panel. 
 
Instrument Type: 
Click the arrow in the Instrument Type box, and select the appropriate instrument type. 
 
Mix Time: 
Enter the desired seconds. 
 
Manual Mode: 
If enabled, user must manually enter all assay results. 
 
Air Blank: 
If enabled, all well reading will be zeroed against the air background. 
 
Note: The Baud Rate, Data Bits, Parity, and Stop Bits will correctly default for each 
instrument type. The Plate Type will default on Generic 96-Well. 
 

3. When you finish, click OK. 
 
 
 
 



IRRITECTION® ASSAY SYSTEM 

Instruction Manual 
CHAPTER 7

Irritection Computer Software 
Instructions

 

©2002                                                  InVitro International                                                     6 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

SECTION TWO: READING NEW ASSAY 
 
I. Selecting the Assay Method 

1. From the Method menu, choose Select. 
2. Select the desired assay method (Ocular, High Sensitivity Ocular, Dermal, or High 

Sensitivity Dermal). 
 

II. Reading the Assay 
1. From the File menu, choose New. 
2. Select Assay. 
3. Select the desired protocol. 
4. Select the desired plate layout. 
5. A series of screens will be displayed. You will need to enter the appropriate assay, and 

sample information. 
 

Note: The Sample Number for each sample must be entered. The Sample Number is 
used as a filename for the datafile that will contain the results of the assay. 

 
6. The plate reader will initialize. Load the assay plate, and click on Continue, or press 

ENTER. 
 
III. Checking Qualifications 

1. After the data collection has been completed, a dialog box will be displayed indicating if 
the assay was qualified or unqualified if an inhibition check is not required. 

2. In an inhibition check is required, a series of screens will appear indicating the specific 
well(s) on the assay plate that require an inhibition check. 

3. Add 25 µl of inhibition check to appropriate well(s). 
4. Wait 5 minutes, load the plate, then click Continue. 
5. A dialog box will indicate if the assay was qualified or unqualified. Click OK to continue. 

 
 
IV. Viewing/Printing Assay Results 

1. A window, which displays the qualified/unqualified assay results section of the report, for 
each sample will be presented. To open additional windows of the sample file (such as 
the protocol, plate layout, calibration curve, response curve, or plate data) go the View 
menu, and choose the desired window to be viewed. To view other samples, activate the 
sample file by clicking on the sample file window. 
Note: For more information on how to use the View command, go to Section 5: 
Using the View Menu. 
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2. To print a complete processed report, go to the File menu, and click Print. (The defaults 
have already been selected for you.) 

 
SECTION THREE: USING THE FILE MENU 
I. New Command 
 A. Assay: 
 The New Assay command allows automatic reading to be performed by a plate reader or  

results to be entered manually by a user. To enable manual mode, go the Instrument  
menu, and choose Setup. Click on Manual Mode. 

   
1. From the File menu, choose New. 
2. Select Assay, and click OK, or press ENTER. 
3. Select the desired protocol, and click OK, or press ENTER. 
4. Select the desired plate layout, and OK, or press ENTER 
5. A series of screens (denoted by underlined headings) will be displayed. The 

following assay and sample information will need to be entered: 
 ASSAY INFORMATION 
Assay 
Incubation Time: 
Refer to your Irritection Assay System protocol to determine the appropriate 
incubation time (24 hours or 5 hours). 
 
Technician Name: 
Enter the user’s name. 
 
Quality Controls 
The Quality Controls are automatically selected by the software. 
 
Reagent 
Kit Lot Number: 
This number can be found on either the Range Specification Sheet (included with 
the kit), kit box or on the bottles. 
 
Temperature: 
Enter the Reagent temperature. 
 
pH Before Activation: 
Enter the pH value. 
 
pH After Activation: 
Enter the pH Value. 
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SAMPLE INFORMATION 
Sample 
Description: 
Enter the sample’s name or description. 
 
Product Type: 
Enter the sample’s product class (e.g., cosmetic, surfactant, industrial chemical) 
 
pH and concentration: 
Enter the pH value and concentration. 
 
Sample Number: 
Select a sample number that will uniquely identify the sample about to be 
processed. This number will be used as the filename for the datafile that will 
contain the results of this assay. 
 
Company: 
Enter your company name. 
 
Comments: 
Additional information about this sample can be entered in this section. 
 
Doses/Concentrations 
Default values will appear in this section. To edit this section, enter the desired 
values for each dose/concentration, then select the appropriate measurement. 
 
Note: The samples in the same assay can be a mixture of solids and liquids. If 
the plate reader fails to initialize, you will need to start and repeat steps 1-4 
and edit the desired doses/concentrations. 
 
Sample Other Results 
Other Results: 
If you have “other results” for a sample, enter those values in this section. Under 
Title, enter the test method; under Measure, enter the filter wavelength; under 
Units, enter the type of score scale (i.e., IDE, HIE, PDII); under the Score, enter 
the numerical irritation score. 
 
6. Click OK. 
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B. Protocol: 
    The New Protocol command allows the creation of a new protocol file (.rpr). 

1. From the File menu, choose New. 
2. Select Protocol, and click OK, or press ENTER. 
3. A dialog box will be displayed asking if you would like to base the “new 

protocol” on an existing protocol. If you click Yes, and existing list of protocols 
will be displayed. Select the desired existing protocol. 

4. A series of screens (denoted by underlined headings) will be displayed. The 
following protocol information will need to be entered: 

  
PROTOCOL INFORMATION 
Protocol: 
Enter the name of the protocol you are creating. 
 
Technician: 
Enter the name of the user. 
 
Score Precision: 
The score precision specifies the number of digits (1 or 2) to be given after the 
decimal point for the irritancy scores. Enter “1” for the Ocular Assay and “2” for 
the Dermal, and High Sensitivity Ocular and Dermal Assays. 
 
Filter Wavelength: 
Enter the appropriate wavelength (400 nm for the Ocular and High Sensitivity 
Ocular Assays and 470 nm for the Dermal and High Sensitivity Dermal Assays). 
 
Number of History Entries Required for Calibrator Substitution from History: 
Enter the number of history entries required in order for a calibrator substitution 
from the history to be performed. (This is only applicable if the Standard Deviation 
or Percentage Test has been enabled.) 
 
History Recording Enabled: 
Enables each calibrator and quality control value to be recorded for every assay 
evaluated with this protocol. The recorded values are used for calculations for the 
standard deviation and percentage tests. Additionally, the history is used for the 
calculation of substitution values for unqualified calibrators. 
 
Allow Calibrator Substitution from History: 
Allows unqualified calibrators to be replaced by a “qualified substitute value” 
(running average of all history entries for that calibrator) generated from the 
history of the assay. 
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Automatic Setting of Assay Date: 
Enables the assay date to be automatically recorded on the software printouts. 
 
Automatic Graph Scaling of Score: 
Enables the software to scale graphs based on the highest reading obtained. 
 
Upper Score (if not using Automatic Graph Scaling for Score): 
Enter the desired upper score. 
 
Assay Method 
The Assay Method is automatically selected by the software. 
 
Doses/Concentrations 
Enter the appropriate doses/concentrations. 
 
Note: This section is only used if manual data entry has been enables. Default 
values for automatic reading by the plate reader are stored in the plate layout 
files (.rpt). 
 
CALIBRATOR DEFINITIONS 
Most of this information can be found on the range specification data sheet 
provided with the kit. Enter Cal 0 through Cal 3 under the Label heading. Enter the 
Calibrator 0 through Calibrator 3 under the Name heading. Enter the “Score”, 
which is the known in vivo value for each calibrator. Enter the “OD” value, which 
is the mean OD value derived from the ranges established from each lot. Enter the 
“Low and High” values, which are derived from the ranges established from each 
lot. 
 
QUALITY CONTROL DEFINITIONS 
This information can be found on the range specification sheet provided with the 
kit. Enter QC 1 and QC 2 under the Label heading. Enter Quality Control 1 and 
Quality Control 2 under the Name heading. Enter the “Score”, which is the mean 
score derived from the ranges established from each lot. Enter the “Low and High” 
values, which are derived from the ranges established from each lot. 
 
Note: The Quality Controls included with the Irritection Assay system do not 
require blank readings. 
 
Number of Quality Controls Used in Assay: 
Enter the number of Quality Controls used. 
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Irritection Class Definitions: 
Enter the Irritection class name, and the lower and upper score range limits. 
 
Allow 10% borderline classifications: 
Allows a sample that is within +/- 10% of a class boundary to be assigned an 
irritation class that is composed of the class below and above the boundary. 
 
CALIBRATOR AND QUALITY CONTROL QUALIFICATION TESTS 
Qualification Enabled: 
If enabled, one of the following three testes will need to be selected for assay 
qualification: (1) Range Test, (2) Standard Deviation Test, or (3) Percentage Test. 
If calibrator and quality control qualification is not enabled in the associated 
protocol, then qualification ranges are not computed and calibrator and quality 
control qualification codes will indicate that qualification has been bypassed.  
 
Range Test: 
If the “Range Test” is selected, qualification will be based on the calibrator/quality 
control upper and lower OD/scores limits specified in the protocol (i.e., if the 
OD/score is within the specified range, the calibrator/quality control will qualify.) 
 
Standard Deviation Test: 
If the “Standard Deviation Test” is selected, and the assay history and required 
number of assay history entries are available, then the lower and upper limits for 
the calibrator ODs and quality control scores are calculated from the history using 
the running average and standard deviation of the calibrator/quality control. If the 
assay history is not available or there are insufficient assay history entries, a dialog 
box will be displayed stating that the qualification test will be changed to the 
“Range Test”. 
 
Percentage Test: 
If the “Percentage Test” us selected, and the assay history and required number of 
assay history entries are available, then the lower and upper limits for the 
calibrator/quality control OD/score will be calculated using the running average 
obtained from the assay history and the percentage tolerance specified in the 
protocol. If the assay history is unavailable or there are insufficient assay history 
entries, then the lower and upper limits for the calibrator/quality control OD/scores 
will be calculated using the calibrator/quality control OD/scores and percentage 
tolerance specified in the associated protocol. 
 
SD Tolerance (+/- SD): 
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Value entered is used to establish a range and specifies the standard error of a 
calibrator/quality control. (e.g., mean ± 2D) 
 
% Tolerance (+/- %): 
Value entered is used to establish a range and specifies the percent error of a 
calibrator/quality control. 
 
Number of History Entries Required for SD or % Testing: 
Enter the number of entries required. 
 
Maximum Number of Unqualified Quality Controls or Calibrators: 
Specifies the maximum number of unqualified quality controls or calibrators an 
assay can have and still quality. 
 
CONCENTRATION RESPONSE CURVE QUALIFICATION TESTS 
Concentration Response Curve Qualification Enabled: 
Enables qualification of a concentration curve by limits or curve-fitting method. 
 
Concentration Above the Highest Qualified Concentration Fail: 
Enables concentration above the highest qualified concentration to fail. 
 
Include Unqualified Concentrations on Concentration Response Curve: 
Includes unqualified concentrations on response curve. 
 
Methods Used to Find the Highest Qualified Concentration 
Limits Method: 
Limits Method will qualify an increasing or flat curve. Each concentration is tested 
beginning with the highest concentration, and progressing to the lowest 
concentration until a concentration fails a test. Each concentration is tested by 
pairing it with every qualified concentration below itself and performing one of 
three tests (Low Range Limit, Mid Range Limit, High Range Limit). The test used 
on these individual pairings depends on the net OD values of the concentration 
under test, as compared to the low and mid range limits specified in the protocol. If 
the net OD is less than the low range limit, the low range limit test is used. If the 
net OD is less than the mid range limit test, then the mid range is used. Otherwise, 
the high range limit test is used. 
 
Curve Fitting Method: 
The Curve Fitting method allows the user to interactively exclude any 
concentrations which are adversely affecting the curve fitting process. Manual 
exclusion of a concentration by the user only affects the values used to perform the 
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curve fitting. (To manually exclude a concentration, go to Section Four: Edit 
Menu). A second order polynomial is fitted to those qualified concentrations and 
associated net OD values which have not been manually excluded. If the curve is 
concave down and the peak is within the range of concentration levels tested, all 
concentrations will qualify. If the curve does not concave down or the peak is not 
within the range of concentration level specified in the assay then the software 
defaults to the Limits Method and will qualify an increasing or flat curve. 
 
Limits Method 
Upper Limit of Low Range: 
The Low Range Limit Test will be performed on samples with the net ODs that are 
below this limit. 
 
Upper Limit of Mid Range: 
The Mid Range Limit Test will be performed on samples with net ODs that are 
below this limit. 
 
Low Range Variability: 
Qualification will be based on the net OD variability allowed between two 
consecutive concentrations when the Low Range Limit Test is performed. 
 
Mid Range Variability: 
Qualification will be based on the net OD variability allowed between two 
consecutive concentrations when the Mid Range Limit Test is performed. 
 
DOSE RESPONSE CURVE QUALIFICATION TESTS 
Dose Response Curve Qualification Enabled: 
Enables qualification of a dose curve by the Empirical or Curve Fitting method. 
 
Consecutive Qualified Doses Required: 
Qualification requires consecutive qualified doses. 
 
Doses Higher than any Failed Dose Also Fail: 
Enables doses higher than any failed doses to also fail. 
 
Require Highest Dose to Qualify: 
Qualification requires highest dose to qualify. 
 
Doses with Increasing Net ODs Qualify: 
Qualification will include doses with increasing net ODs. 
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Doses Above the Highest Qualified Dose Fail: 
Qualification will not include doses above highest qualified dose. 
 
Include Unqualified Doses on Dose Response Curve: 
Dose response curve will include unqualified doses. 
 
Methods Used to Find the Highest Qualified Dose 
Empirical Method: 
The Empirical method will qualify an increasing or flat curve. The sample doses 
are tested in groups of three (e.g., doses 1 through 3, doses 2 through 4). The 
qualification depends on the net OD of the doses within a group. If any of the net 
ODs fall into the low, mid or high range, the Low Range Limit, Mid Range Limit, 
or High Range Limit Test, respectively, will be performed. 
 
Curve Fitting Method: 
The Curve Fitting method allows the user to interactively exclude any doses which 
are adversely affecting the curve fitting process. Manual exclusion of a dose by the 
user only affects the values used to perform the curve fitting. (To manually exclude 
a dose, go to Section Four: Edit Menu). A second order polynomial is fitted to 
those qualified doses and associated net OD values which have not been manually 
excluded or automatically eliminated. If the curve is concave down and the peak is 
within the range of dose levels used in the assay, then all of the doses of the curve 
are qualified. If the curve does not concave down or the peak is not within the 
range of dose levels specified in the assay, then the software defaults to the 
Empirical Method and will qualify an increasing or flat curve. 
 
Minimum Number of Qualified Doses: 
Qualification based on this minimum number of qualified doses. 
 
Low Range Flatness 
For OD <: 
The Low Range Test will be performed when a sample net OD is below this value. 
 
Pt to Pt <: 
Qualification will be based on the net OD variability allowed between two 
consecutive doses. 
 
Overall <: 
Qualification will be based on the net OD variability allowed between the highest 
and lowest doses in a group of three doses. 
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Mid Range Flatness 
For OD <: 

The Mid-Range Test will be performed when a sample net OD is below this value. 
 
Pt to Pt <: 
Qualification will be based on the net OD variability allowed between two 
consecutive doses. 
 
Overall <: 
Qualification will be based on the net OD variability allowed between the highest 
and lowest doses in a group of three doses. 
 
OTHER QUALIFICATION TESTS 
Inhibition Test 
None: 
If enabled, an inhibition test will not be performed. 
 
Highest: 
An inhibition check will need to be performed if the net OD for the maximum 
qualified sample dose or concentration is < Cal 2. 
 
Individual: 
An inhibition check will need to be performed if the net OD for any selected 
sample dose or concentration is < Cal 2. 
 
Individual Inhibition Check 
Select the desired doses that require an inhibition check. 
 
B0 Test 
Minimum B0 OD: 
Qualification is based on this minimum OD value. 
 
Maximum B0 OD: 
Qualification is based on this maximum OD value. 
 
Blank Tests 
Blank Qualification Enabled: 
Enables each blank OD for each sample to be tested. The blanks must pass a range 
test, and in some cases, a blank flatness check. 
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Minimum Blank OD: 
Qualification will be based on this minimum OD value. 
 
Maximum Blank OD: 
Qualification will be based on this maximum OD value. 
 
Blank to Blank Flatness: 
Qualification will be based on the blank OD variability allowed between tow 
consecutive doses. 
 
Blank Overall Flatness: 
Qualification will be based on the blank OD variability allowed between the 
highest and lowest doses in a group of three doses. 
 
Net OD Tests 
Net Qualification Enabled: 
Enables each sample dose or concentration which has not failed a previous 
qualification test to be tested for net OD acceptability. The net OD must be within 
the limits specified in the protocol. 
 
Minimum Net OD: 
Qualification is based on this minimum OD value. 
 
5. When you finished, click OK. 

 
C. Plate Layout: 
    The New Plate Layout allows the creation of a new plate layout files (.rpt). 
 

1. From the File menu, select New. 
2. Select Plate Layout, and click OK, or press ENTER. 
3. A dialog box will be displayed asking if you would like to base the “new plate 

layout” on an existing plate layout. If you click Yes, and existing list of plate 
layouts will be displayed. Select the desired existing plate layout. 

4. A screen will appear and the appropriate plate layout information will need to 
be entered. The dose/concentration settings entered will be default values that 
appear on the sample information screen when automatically reading an assay. 
When you have finished, click OK or press ENTER. 

5. A plate layout will be displayed. With your mouse “drag” the labeled wells into 
the desired plate configuration. Use the “empty well” to correct any mistakes. 

6. When you finish, go to the File menu, and select Close. 



IRRITECTION® ASSAY SYSTEM 

Instruction Manual 
CHAPTER 7

Irritection Computer Software 
Instructions

 

©2002                                                  InVitro International                                                     17 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

7. A dialog box will appear asking if you would like to save the new plate layout. 
Select Yes. 

 
II. Open Command 

1. From the File menu, select Open. 
2. In the File Name box, type or select the name of the document you want to 

open. 
Note: As you select the file you want, the protocol and plate layout names 
will appear in the boxes below. If you do not see the name of the file you 
want, select a different type of file from the Lit of Files of Type box 
(sample files=.rpk; protocol file=.rpr; plate layout file=.rpt; history 
file=.rpd). 

3. When you finish, select OK. 
 
III. Close Command 

1. From the File menu, select Close. This will close the active window. 
2. If a document has changes you have not saved, a dialog box will be displayed 

asking if you want to save the changes before closing. If you choose Yes, but 
have not given the file name, the Save As dialog box will be displayed. 

 
IV. Save/Save As Commands 

1. To save existing or open file(s), go to the File menu, and select Save. 
2. To save a changed sample file name (number), go to the File menu, and select 

Save As. A Save As dialog box will be displayed. Type the new file name in the 
File Name box, and select OK. 
Note: When a new protocol or plate layout file is created, DOS file names 
are automatically assigned and saved with the file. 

 
V. Print Command 

1. To print, go to the File menu, and select Print. 
2. The defaults for the Print Selection have already been set for you. To print 

additional sections, click on the box next to the desired selection. When you 
finish, select OK. 

VI. Print Setup Command 
1. From the File menu, select Print Setup. 
2. Select the appropriate print setup options. 
3. When you finish, select OK. 

 
VII. Exit Command 

1. To exit out of Irritection Software, go to the File menu, and select Exit. 
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SECTION FOUR: USING THE EDIT MENU 
I. Assay Command 

1. From the File menu, choose Open. Open the desired sample (.rpk) file. 
2. From the Edit menu, choose Assay. 
3. A series of screens will be displayed. Edit the assay report section of the 

sample file. When you finish, click OK. 
4. A dialog box will be displayed stating if the “edited assay” was qualified or not 

qualified. 
 
II. Protocol Command 

Note: you can either edit the protocol section of a sample file (.rpk), or edit the 
protocol file (.rpr) itself. Changes made on the active file only be updated for that 
specific file (i.e., if a sample file (.rpk) is open and you edit the protocol section of 
that sample file, the protocol for that sample file will be update, but the protocol file 
(.rpr) will not be update.) 

 
1. From the File menu, choose Open. Open either the desired sample (.rpk) file or 

protocol (.rpr) file. 
2. From the Edit menu, choose Protocol. 
3. A series of screens will be displayed. Edit the desired sections. When you 

finish, click OK. 
 

Note: if you choose to edit the protocol section of a sample file, you will not 
see the edited protocol changes unless you view the protocol report for that 
sample file. For more details on the View menu, go to Section Five: Using 
the View Menu. 

 
4. After you have edited the protocol section of a sample file (.rpk), you will need 

to recompute for assay qualification. From the Edit menu, choose Recompute 
Assay. 

5. A dialog box will be displayed stating if the assay has qualified using the 
“edited protocol”. 

6. To save the changed, go to the File menu, choose Save. 
 
 
III. Plate Layout Info. Command 

Note: you can either edit the plate layout info. Section of a sample file (.rpk), or edit 
the plate layout file (.rpt) itself. Changes made on the active file will only be updated 
for that specific file. 
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1. From the File menu, choose Open. Open either the desired sample (.rpk) file or 
plate layout (.rpt) file. 

2. From the Edit menu, choose Plate Layout Info. 
3. Edit the sections of the Plate Layout Info. When you finish, click OK. 

 
IV. Scales Command 

Note: You can edit the scales of either your sample calibrator or sample response 
curve. 

 
1. From the File menu, choose Open. Open the sample (.rpk) you wish to edit. 
2. From the View menu, choose Calibrator or Response Curve. 
3. From the Edit menu, choose Scales. 
4. Edit the X and/or Y axis maximum values. When you finish click OK. 

 
V. Response Curve Command 

Note: You can only edit the response curve if “curve fitting” was selected in the 
associated protocol as the method used to qualify the response curve. 

 
1. From the File menu, choose Open. Open the sample (.rpk) you wish to edit. 
2. From the View menu, choose Response Curve. 
3. From the Edit menu, choose Response Curve. 
4. Exclude the desired concentration(s)/dose(s). When you finish click OK. 

 
VI. Recompute Assay Command 

Note: If the protocol section of a sample file has been edited, qualification checks 
based on the edited protocol must be performed. 

 
1. From the Edit menu, choose Recompute Assay. 
2. Qualification checks will be performed based on the edited protocol. 
3. A dialog box will appear stating whether the assay was qualified or 

unqualified. 
VII. History Command 
 

A. Edit History Entries 
1. From the Edit menu, choose History. 
2. Select Edit History Entries. 
3. Select the history you wish to edit by protocol name. When you finish, click 

OK. 
4. A series of screens from Cal 0 to QC 2 will be displayed. Edit the desired 

sections by either clicking Insert or Delete. When you finish, click OK. 
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B. Update History with all Sample Files/Rebuild History with all Sample Files 
1. From the Edit menu, choose History. 
2. Select Update History with all Sample Files/Rebuild History with all Sample 

Files. When you finish, Click OK. 
 

C. Clear History 
1. From the Edit menu, choose History. 
2. Select Clear History. When you finish, click OK. 
 

D. Recover Previous History 
1. From the Edit menu, choose History. 
2. Select Recover Previous History. When finish, click OK. 

 
 
SECTION FIVE: USING THE VIEW MENU 
I. View Command 
 Note: The View Command only works with an active sample file (.rpk) 

1. From the File menu, choose Open. Open the desired sample file. 
2. From the View menu, choose either Assay, Protocol, Plate Layout, Calibrator 

Curve, Response Curve or Plate Data. 
 
 
SECTION SIX: USING THE INSTRUMENT MENU 
I. Retract/Extend Plate Commands 

Note: The retract and extract commands allows you to manually retract or extend 
the plate reader. 

1. To retract/extend the plate from the plate reader, go to the Instrument menu, 
and choose Retract/Extract. 

 
II. Setup 

The following steps should be performed during the software installation process. 
1. From the Instrument menu, and choose Setup. 
2. You will need to enter the following system parameters (this needs to only be 

done once): 
 

Comm Port: 
Select the appropriate Comm Port. 
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Filters (nm): 
The wavelength of each filter installed on the filter wheel of the plate reader 
will need to be entered in order for the program to choose the correct filter when 
reading. Enter zero to indicate an empty position. 
 
Serial Number: 
The serial number of the plate reader will need to be entered. 
Note: If you have the Cambridge plate reader, the serial number can be 
found inside the plate reader on the left corner panel. For the Molecular 
Devices or Dynatech plate reader, the serial number can be found on the 
rear panel. 
 
Instrument Type: 
Click the arrow in the Instrument Type box, and select the appropriate 
instrument type. 
Note: The Baud Rage, Data Bits, Parity, and Stop Bits will correctly default 
for each instrument type. The Plate Type will default on Generic 96-Well. 
 
Mix Time: 
Enter the desired seconds. 
 
Manual Mode: 
If enabled, user must manually enter all assay results. 
 
Air Blank: 
If enabled, the B0 well value will not be subtracted from every well of the 
reading plate. 

 
 
SECTION SEVEN: USING THE METHOD MENU 
I. Select Command 

1. From the Method menu, and choose Select. 
2. Select the desired Assay Method. 

Note: The data path displays the directory where the sample, protocol, 
plate layout and history files are stored. 

 
SECTION EIGHT: WINDOW MENU 
 
Note: The window menu allows you to arrange your active files in either cascade, tile 
horizontally, or tile vertically. All active window files are listed under the window. 
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TRAINING SCHEDULE: 
OCULAR AND DERMAL RESPONSE ASSAYS1 

 

DAY 1: 
 
8:00–8:30 AM INTRODUCTION TO THE OCULAR RESPONSE ASSAYS 

 
• Description of Background and Scientific Basis 
• Comparison of Irritection Assay System and In Vivo Test Results 
• Description of Kit components 
• Overview of Protocols and Procedures 

  
8:30–10:00 AM PERFORM A 5 HOUR OCULAR IRRITECTION ASSAY 

 
• Utilize the Surfactant Protocol 
• Perform a Concentration-Dependent Study (4 Samples with 5 

Concentrations) 
  
10:00–10:30 AM INTRODUCTION TO THE DERMAL RESPONSE ASSAYS 

 
• Description of Background and Scientific Basis 
• Comparison of Irritection Assay System and In Vivo Test Results 
• Description of Kit components 
• Overview of Protocols and Procedures 

  
10:30-12:00 PM PERFORM A 24 HOUR DERMAL IRRITECTION ASSAY 

 
• Utilize the Cosmetic Protocol 
• Perform a Volume-Dependent Study (4 Samples with 5 Volumes) 

  
12:00-1:00 PM BREAK FOR LUNCH 
  
1:00-2:30 PM IRRITECTION SOFTWARE TRAINING 

 
• Install Irritection software for Windows Version 1.00 
• Description of the Software and its use 

 
 
1 Prior to training, please review all protocol procedures, prepare samples as required, and adjust 
the incubator to maintain a temperature of 25˚C. 
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2:30–3:30 PM COMPLETE THE OCULAR RESPONSE ASSAY 
 

• Read the Assay Results 
• Analyze and Interpret the Data 

 
DAY 2: 
 
9:30–11:30 AM REVIEW AND DISCUSSION 

 
• Review Ocular Response Assay Results 
• Discuss Qualification of Assay Results 
• Discuss Data Interpretation 
• Describe Troubleshooting Techniques 

  
11:30-12:30 PM COMPLETE THE DERMAL RESPONSE ASSAY 

 
• Read the Assay Results 
• Analyze and Interpret the Data 

  
12:30-1:30 PM BREAK FOR LUNCH 
  
1:30-2:30 pm FINAL QUESTIONS AND COMMENTS 
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CUSTOMER-SUPPLIED REQUIRED EQUIPMENT 
 

96-Well microtiter platereader such as: 
  

Cambridge (filters: 400 nm and 470 nm) 
  

Molecular Devices (filters: 405 nm and 450 nm) 
  

Dynatech (filters: 405 nm and 450 nm) 
User of Dynatech platereader may require Smart Cable (SC817RM) from IQ 
Technology (1-800-227-2817) 

 
IBM compatible PC with Irritection Software 
 
Incubator maintained at 25˚C ± 1˚C. 
 
Balance (110 g capacity) 
 
pH Meter 
 
Vortex mixer 
 
Positive displacement micro pipetter, 5 – 250 µl capacity 
 
Multichannel expandable pipetter, 15 – 1250 µl capacity* 
 
Disposable reservoir trays, 100 ml capacity 
 
Graduated cylinder, 100 ml capacity 
 
Beaker, 100 ml capacity 
 
Funnel, 12.5 cm diameter 
 
Plastic forceps 
 
Plastic wrap 
 
* Option: 8 channel manual pipetter, 0 – 250 µl capacity and a repeating pipetter, 250 – 1250 µl  
                capacity. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40000 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response Reagent Powder 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

To our knowledge, this product contains no hazardous components. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: White lyophilized powder. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Appropriate Foam. 
Special Firefighting Procedure: Wear yourself contained breathing apparatus and  
protective clothing to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhalation, ingestion, or skin absorption. Prolonged or  
repeated exposure may cause allergic reactions in certain sensitive individuals.  
First Aid: If swallowed, wash out mouth with water, provided person is conscious. Call a  

physician. 
In case of skin contact, flush with copious amounts of water. 
If inhaled, remove to fresh air. If breathing becomes difficult, give oxygen. 
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In case of contact with eyes, flush with copious amounts of water for at least 15  
minutes.  
Assure adequate flushing by separating the eyelids with fingers. 
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Stability: Stable 
Hazardous Combustion or Decomposition Product: The nature of decomposition products  
are not known. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wear safety goggles and gloves.  
Sweep up, place in a bag and hold for waste disposal. Avoid raising dust. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Mechanical  
exhaust required.  

Label precautionary statements: Caution – the chemical, physical and toxicological  
properties of this product have not been thoroughly investigated. Exercise due care. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40001 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response Hydrating Solution 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An inorganic aqueous solution, slightly acidic to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
Boiling Point: NA 
Vapor Pressure: NA 

 
Section V: FIRE AND EXPLOSION HAZARD 
 

Flashpoint: NA 
Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. May be harmful if inhaled or absorbed through skin.  
First Aid: In case of eye contact, flush eyes or skin with copious amount of water.  

If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
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becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Alkali Metals (e.g. Lithium and Sodium). 
Hazardous Combustion or Decomposition Product: None. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid  
contact with eyes, skin and clothing. Wash thoroughly after handling. Keep  
tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40002 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response Blanking Buffer 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A buffered solution, alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Dry Chemical Powder. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. May be harmful if inhaled or absorbed through skin.  
First Aid: In case of eye contact, flush eyes or skin with copious amount of water.  

If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 

If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 
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Section VII: REACTIVITY DATA 
 

Incompatibles: Strong acids and strong bases. 
Hazardous Combustion or Decomposition Product: Nature of decomposition products not known. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
skin, or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40003 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response Activator 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

Inorganic aqueous solution, acidic to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder, Alcohol or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhaled, ingestion or skin absorption.  
First Aid: In case of eye contact, immediately flush eyes with copious amount of water. In case of  

skin contact, immediately wash skin with soap and copious amounts of water. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
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Section VII: REACTIVITY DATA 
 

Incompatibles: Strong bases, strong oxidizing agents, air sensitive, moisture sensitive. 
Hazardous Combustion or Decomposition Product: Sulfur Oxides. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. 
 

Section X: SPECIAL PRECAUTIONS 
 

Avoid contact with eyes, skin, or on clothing. Avoid prolonged or repeated exposure. Wash 
thoroughly after handling. Irritant. Store in a cool dry place. 

 
 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40004 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response Inhibition check 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A dilute aqueous solution of a weak organic base, slightly alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Water Sprays. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. 
First Aid: In case of contact, flush eyes or skin with copious amount of water.  

If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 
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Section VII: REACTIVITY DATA 
 

Incompatibles: Anionic detergents and nitrates. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide,  
Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
skin, or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40005 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response Cal 0 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A buffered solution of a pH balanced inorganic base. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Water Sprays. 
 

Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. 
First Aid: In case of contact, flush eyes or skin with copious amount of water. 

If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 
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Section VII: REACTIVITY DATA 
 

Incompatibles. Strong acids or bases. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin, or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40006 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response Cal 1 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

Solution of weak organic acid and poly-ol alcohol 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless, viscous liquid. 
Boiling Point: NA 
Vapor Pressure: NA 

 
Section V: FIRE AND EXPLOSION HAZARD 
 

Flash Point: NA 
Extinguishing Media: Water Spray , Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. May be harmful if inhaled or absorbed through the skin.  
Causes eye and skin irritation. 

First Aid: In case of contact, flush eyes or skin with copious amount of water.  
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Oxidizing Agents, Bases, Reducing Agents. 
Hazardous Combustion or Decomposition Product: Toxic Fumes of Carbon Monoxide and 
Carbon Dioxide. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin and clothing. Wash thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40007 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response Cal 2 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

Solution of weak organic acid and poly -ol alcohol 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless, viscous liquid. 
Boiling Point: NA 
Vapor Pressure: NA 

 
Section V: FIRE AND EXPLOSION HAZARD 
 

Flash Point: NA 
Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. May be harmful if inhaled or absorbed through the skin.  
Causes eye and skin irritation. Material is irritating to mucous membranes and upper  
respiratory tract. 
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First Aid: In case of contact, immediately flush eyes or skin with copious amount of water.  
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
Wash contaminated clothing before reuse. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Oxidizing Agents, Bases, Reducing Agents. 
Hazardous Combustion or Decomposition Product: Toxic Fumes of Carbon Monoxide and 
Carbon Dioxide. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin and clothing. Wash thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40008 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response Cal 3 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

Weak aqueous solution of an organic acid. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
Boiling Point: NA 
Vapor Pressure: NA 

 
Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed or absorbed through the skin.  
First Aid: In case of contact, immediately flush eyes or skin with copious amount of water.  
Remove contaminated clothing and shoes. Assure adequate flushing of the eyes by separating the  
eyelids with fingers. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
Wash contaminated clothing before reuse. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Bases. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Do not breathe vapor. Readily absorbed through skin. Wash thoroughly 
after handling. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40009 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response QC 1 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous solution of inorganic salt. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if inhaled or swallowed. May cause eye and skin irritation. To the best of  
our knowledge, the chemical, physical and toxicological properties have not been thoroughly  
investigated.  
First Aid: In case of contact, immediately flush eyes or skin with copious amount of water.  
In case of contact, immediately wash the skin with soap and copious amounts of water. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
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becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Alkali Metals (e.g. Lithium, Sodium) 
Hazardous Combustion or Decomposition Product: None. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear safety goggles, chemical-resistant gloves, and other protective clothing. Safety shower and 
eye bath. Avoid contact with eyes, skin and clothing. Wash thoroughly after handling. Keep 
tightly closed. 

 
Section X: SPECIAL PRECAUTIONS 
 

Store in a cool, dry place. 
 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 



IRRITECTION® ASSAY SYSTEM 

Instruction Manual 
CHAPTER 9

Material Safety Data Sheets
 

©2002                                                  InVitro International                                                     22 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

 
Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40010 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Ocular Response QC 2 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

Weak aqueous solution of an organic acid. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
Boiling Point: NA 
Vapor Pressure: NA 

 
Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed or absorbed through skin.  
First Aid: In case of contact, immediately flush eyes or skin with copious amount of water. 
Remove contaminated clothing and shoes. Assure adequate flushing of the eyes by separating the 
eyelids with fingers. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
Wash contaminated clothing before reuse. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Bases. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Do not breathe vapor. Readily absorbed through skin. Wash thoroughly 
after handling. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40011 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response 
  Reagent Powder 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

To our knowledge, this product contains no hazardous components. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Light Yellow lyophilized powder. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhalation, ingestion, or skin absorption. Prolonged or repeated  
exposure may cause allergic reactions in certain sensitive individuals. 
First Aid: If swallowed, wash out mouth with water, provided person is conscious. 
In case of skin contact, flush with copious amount of water.  



IRRITECTION® ASSAY SYSTEM 

Instruction Manual 
CHAPTER 9

Material Safety Data Sheets
 

©2002                                                  InVitro International                                                     25 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

If inhaled, remove to fresh air. If breathing becomes difficult, give oxygen. 
In case of contact with eyes, flush with copious amounts of water for at least 15 minutes. Assure  
adequate flushing by separating the eyelids with fingers. 
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Stability: Stable. 
Hazardous Combustion or Decomposition Product: The nature of decomposition products are not 
known. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wear safety goggles and gloves. Sweep up, 
place in a bag and hold for waste disposal. Avoid raising dust. 
Waste Disposal Method: The substance can be disposed of as regular waste. 

 
Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Mechanical exhaust 
required. Label Precautionary Statements: Caution – The chemical, physical and toxicological 
properties of this product have not been thoroughly investigated. Exercise due care. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    40012 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response 
  Hydrating Solution 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An inorganic aqueous solution, slightly acidic to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
Boiling Point: NA 
Vapor Pressure: NA 

 
Section V: FIRE AND EXPLOSION HAZARD 
 

Flashpoint: NA 
Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. May be harmful if inhaled or absorbed through skin.  
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Causes eye and skin irritation. 
First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Alkali Metals (e.g. Lithium and Sodium). 
Hazardous Combustion or Decomposition Product: None. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin and clothing. Wash thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    40013 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response 
  Blanking Buffer 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A buffered solution, alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Dry Chemical Powder. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. May be harmful if inhaled or absorbed through skin.  
Causes eye and skin irritation. 
First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  



IRRITECTION® ASSAY SYSTEM 

Instruction Manual 
CHAPTER 9

Material Safety Data Sheets
 

©2002                                                  InVitro International                                                     29 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Strong acids and strong bases. 
Hazardous Combustion or Decomposition Product: Nature of decomposition products not known. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    40014 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response - Cal 0 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A buffered solution of a pH balanced inorganic base. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Water Spray. 
 

Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. 
First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 
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Incompatibles: Strong acids or bases. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    40015 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response – Cal 1 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous, inorganic acid solution. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless, odorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  
Unusual Fire and Explosions Hazards: Emits toxic fumes under fire conditions. 

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if inhaled or swallowed. May be harmful if absorbed through the skin.  
Causes severe eye irritation. May cause skin irritation. 
First Aid: In case of contact, immediately flush eyes or skin with copious amount of water. 
Assure adequate flushing of the eyes by separating the eyelids with fingers. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
Wash contaminated clothing before reuse.  

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Bases. 
Hazardous Combustion or Decomposition Product: Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid inhalation. 
Do not get in eyes, on skin or on clothing. Avoid prolonged or repeated exposure. Wash 
thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    40016 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response – Cal 2 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous, inorganic acid solution. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  
Unusual Fire and Explosion Hazards: Emits toxic fumes under fire conditions. 

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if inhaled or swallowed. May be harmful if absorbed through skin.  
Causes severe eye irritation. May cause skin irritation. 
First Aid: In case of contact, flush eyes or skin with copious amount of water. Assure adequate 
flushing of the eyes by separating the eyelids with fingers. 



IRRITECTION® ASSAY SYSTEM 

Instruction Manual 
CHAPTER 9

Material Safety Data Sheets
 

©2002                                                  InVitro International                                                     35 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
Wash contaminated clothing before reuse. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Bases. 
Hazardous Combustion or Decomposition Product: Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid inhalation. 
Do not get in eyes, on skin or on clothing. Avoid prolonged or repeated exposure. Wash 
thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    40017 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response – Cal 3 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous, inorganic acid solution. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  
Unusual Fire and Explosion Hazards: Emits toxic fumes under fire conditions. 

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if inhaled or swallowed. May be harmful if absorbed through the skin.  
Causes severe eye irritation. May cause skin irritation. 
First Aid: In case of contact, flush eyes or skin with copious amount of water. Assure adequate 
flushing of the eyes by separating the eyelids with fingers. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
Wash contaminated clothing before reuse. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Bases. 
Hazardous Combustion or Decomposition Product: Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid inhalation. 
Do not get in eyes, on skin or on clothing. Avoid prolonged or repeated exposure. Wash 
thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    40018 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response – QC 1 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous solution of inorganic salt. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhalation, ingestion or skin absorption. May cause irritation.  
To the best of our knowledge, the chemical, physical and toxicological properties have not been  
thoroughly. 
First Aid: In case of contact, immediately flush eyes with copious amount of water.  
In case of contact, immediately wash skin with soap and copious amount of water. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Alkali Metals (e.g. Lithium, Sodium). 
Hazardous Combustion or Decomposition Product: None. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin and clothing. Do not breath vapor. Wash thoroughly after handling. Keep tightly 
closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    40019 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response – QC 2 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An diluted aqueous solution of a weak organic base, slightly alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Water Spray. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. 
First Aid: In case of contact, flush eyes or skin with copious amount of water.  
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 

 
Section VII: REACTIVITY DATA 
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Incompatibles: Anionic agents and nitrates. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide, 
Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    40020 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response Activator 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

Inorganic aqueous solution, acidic to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder, Alcohol or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  
Unusual Fire and Explosions Hazards: Emits toxic fumes under fire conditions. 

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhalation, ingestion or skin absorption. 
First Aid: In case of eye contact, immediately flush eyes with copious amount of water. In case of 
skin contact, immediately wash skin with soap and copious amounts of water. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
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becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 

 
Section VII: REACTIVITY DATA 

 
Incompatibles: Strong bases, strong oxidizing agents, air sensitive, moisture sensitive. 
Hazardous Combustion or Decomposition Product: Sulfur  Oxides. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin an clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling. 
Irritant. Store in a cool dry place. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    40021 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Ocular Response 
  Inhibition Check 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A diluted aqueous solution of a weak organic base, slightly alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder, or Water Spray. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. 
First Aid: In case of contact, flush eyes with copious amount of water. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 
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Section VII: REACTIVITY DATA 

 
Incompatibles: Anionic agents and nitrates. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide, 
Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50000 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response Reagent Powder 
   
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

To out knowledge, this product contains no hazardous components. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: White lyophilized powder. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Appropriate Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhalation, ingestion, or skin absorption. Prolonged or repeated  
exposure may cause allergic reactions in certain sensitive individuals. 
First Aid: If swallowed, wash out mouth with water, provided person is conscious. Call a 
physician. 
In case of skin contact, flush with copious amount of water. 



IRRITECTION® ASSAY SYSTEM 

Instruction Manual 
CHAPTER 9

Material Safety Data Sheets
 

©2002                                                  InVitro International                                                     47 

17751 Sky Park East, Suite G 
Irvine, California, 92614 

 

If inhaled, remove to fresh air. If breathing becomes difficult, give oxygen. 
In case of contact with eyes, flush with copious amounts of water for at least 15 minutes. Assure 
adequate flushing by separating the eyelids with fingers. 
Call a physician. 

 
Section VII: REACTIVITY DATA 

 
Stability: Stable. 
Hazardous Combustion or Decomposition Product: The nature of decomposition products are not 
known. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wear safety goggles and gloves. Sweep up, 
place in a bag and hold for waste disposal. Avoid raising dust. 
Waste Disposal Method: The substance can be disposed of as regular waste. 

 
Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Mechanical exhaust 
required.  
Label precautionary statements: Caution – The chemical, physical and toxicological properties of 
this product have not been thoroughly investigated. Exercise due care. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    50001 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response Hydrating Solution 
   
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An inorganic aqueous solution, alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
Boiling Point: NA 
Vapor Pressure: NA 

 
Section V: FIRE AND EXPLOSION HAZARD 
 

Flashpoint: NA 
Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder, or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. May be harmful if inhaled or absorbed through the skin.  
Causes eye and skin irritation. 
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First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 

 
Section VII: REACTIVITY DATA 

 
Incompatibles: Alkali Metals (e.g. Lithium, Sodium) and Acids. 
Hazardous Combustion or Decomposition Product: None. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin and clothing. Wash thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    50002 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response Blanking Buffer 
   
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A buffered solution, alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Dry Chemical Powder 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed.  
First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
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Section VII: REACTIVITY DATA 

 
Incompatibles: Strong acids and strong bases. 
Hazardous Combustion or Decomposition Product: Nature of decomposition products not known. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    50003 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response Activator 
   
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

Inorganic aqueous solution, acidic to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Regular Foam 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  
Unusual Fire and Explosions Hazards: Emits toxic fumes under fire conditions. 

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhaled, ingestion or skin absorption. Causes eye and skin  
irritation. 
First Aid: In case of eye contact, immediately flush eyes with copious amount of water. In case of 
skin contact, immediately wash skin with soap and copious amounts of water. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 

 
Incompatibles: Strong bases, strong oxidizing agents, air sensitive, moisture sensitive. 
Hazardous Combustion or Decomposition Product: Sulfur Oxides. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing.  
 

Section X: SPECIAL PRECAUTIONS 
 

Avoid contact with eyes, skin and clothing. Avoid prolonged or repeated exposure. Wash 
thoroughly after handling. Irritant. Store in a cool dry place. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    50004 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response Inhibition Check 
   
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A diluted aqueous solution of a weak organic base, slightly alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Water Spray 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed.  
First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 
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Section VII: REACTIVITY DATA 

 
Incompatibles: Anionic agents and nitrates. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide, 
Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50005 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response – Cal 0 
   
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous organic salt solution, alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Regular Foam 
 

Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Direct contact may cause eye irritation. Harmful if swallowed.  
First Aid: In case of contact, flush eyes or skin with copious amount of water. If irritation persists,  
call a physician. 

 
Section VII: REACTIVITY DATA 

 
Incompatibles: Strong Oxidizing Agents. 
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Hazardous Combustion or Decomposition Product: Toxic fumes of Carbon Dioxide and Carbon 
Monoxide. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50006 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response – Cal 1 
   
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A diluted aqueous solution of a weak organic base, slightly alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Water Spray. 
 

Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed.  
First Aid: In case of contact, flush eyes or skin with copious amount of water.  
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 
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Section VII: REACTIVITY DATA 

 
Incompatibles: Anionic agents and nitrates. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide, 
Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50007 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response – Cal 2 
   
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A diluted aqueous solution of a weak organic base, slightly alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Water Spray. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed.  
First Aid: In case of contact, flush eyes or skin with copious amount of water.  
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 
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Section VII: REACTIVITY DATA 

 
Incompatibles: Anionic agents and nitrates. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide, 
Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50008 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response – Cal 3 
   
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

Solution of a weak organic acid and poly –ol alcohol. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
Boiling Point: NA 
Vapor Pressure: NA 

 
Section V: FIRE AND EXPLOSION HAZARD 
 

Flashpoint: NA 
Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. May be harmful if inhaled or absorbed through the skin.  
Causes eye and skin irritation. 
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First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 

 
Section VII: REACTIVITY DATA 

 
Incompatibles: Oxidizing Agents, Bases, Reducing Agents. 
Hazardous Combustion or Decomposition Product: Toxic Fumes of Carbon Monoxide and 
Carbon Dioxide. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin and clothing. Wash thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50009 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response – QC 1 
   
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous solution of inorganic salt. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhalation, ingestion or skin absorption. May cause irritation.  
To the best of our knowledge, the chemical, physical and toxicological properties have not been  
thoroughly investigated. 
First Aid: In case of contact, immediately flush eyes with copious amount of water. 
In case of contact, immediately wash skin with soap and copious amount of water. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 

 
Incompatibles: Alkali Metals (e.g. Lithium, Sodium). 
Hazardous Combustion or Decomposition Product: None. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin and clothing. Do not breathe vapor. Wash thoroughly after handling. Keep tightly 
closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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Date: 08/96         Revision: 1 

 
MATERIAL SAFETY DATA SHEET    50010 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: Dermal Response - QC 2 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous, organic salt solution. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless, odorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  
Unusual Fire and Explosions Hazards: Emits toxic fumes under fire conditions. 

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if inhaled or swallowed. May be harmful if absorbed through skin.  
Causes severe eye irritation. May cause skin irritation. 
First Aid: In case of contact, immediately flush eyes or skin with copious amount of water. 
Assure adequate flushing of the eyes by separating the eyelids with fingers. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
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becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
Wash contaminated clothing before reuse. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: None. 
Hazardous Combustion or Decomposition Product: Toxic Fumes of Carbon Monoxide, Carbon 
Dioxide and Sulfur Oxides. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid inhalation. 
Do not get in eyes, on skin or on clothing. Avoid prolonged or repeated exposure. Wash 
thoroughly after handling. Irritant. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50011 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response 
  Reagent Powder 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 
 To our knowledge, this product contains no hazardous components. 

 
Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Light yellow lyophilized powder. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Appropriate Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhalation, ingestion, or skin absorption. Prolonged or repeated  
exposure may cause allergic reactions in certain sensitive individuals. 
First Aid: If swallowed, wash out mouth with water, provided person is conscious. 
In case of skin contact, flush with copious amount of water.  
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If inhaled, remove to fresh air. If breathing becomes difficult, give oxygen. 
In case of contact with eyes, flush with copious amount of water for at least 15 minutes. Assure 
adequate flushing of the eyes by separating the eyelids with fingers. 
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Stability: Stable. 
Hazardous Combustion or Decomposition Product: The nature of decomposition products are not 
know. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wear safety goggles and gloves.  
Sweep up, place in a bag and hold for waste disposal. Avoid raising dust. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Mechanical exhaust 
required.  
Label precautionary statements: Caution – The chemical, physical and toxicological  
properties of this product have not been thoroughly investigated. Exercise due care. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50012 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response 
  Hydrating Solution 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 
 An inorganic aqueous solution, slightly acidic to litmus. 

 
Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
Boiling Point: NA 
Vapor Pressure: NA 

 
Section V: FIRE AND EXPLOSION HAZARD 
 

Flashpoint: NA 
Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. May be harmful if inhaled or absorbed through skin.  
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Causes eye and skin irritation. 
First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing becomes  
difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. 
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Alkali Metals (e.g. Lithium and Sodium) 
Hazardous Combustion or Decomposition Product: None. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin and clothing. Wash thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50013 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response 
  Blanking Buffer 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 
 A buffered solution, alkaline to litmus. 

 
Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Dry Chemical Powder. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. May be harmful if inhaled or absorbed through skin.  
Causes eye and skin irritation. 
First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing becomes  
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difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. 
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Strong acids and strong bases. 
Hazardous Combustion or Decomposition Product: Nature of decomposition products not known. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50014 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response – Cal 0 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 
 A buffered solution of a pH balanced inorganic base. 

 
Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
 

Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Direct contact my causes eye irritation. Harmful if swallowed. 
First Aid: In case of contact, flush eyes with copious amount of water. 
If swallowed, wash out mouth with water, provided person is conscious. 
Call a physician. 

 
Section VII: REACTIVITY DATA 
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Incompatibles: Strong acids and bases. 
Hazardous Combustion or Decomposition Product: Toxic Fumes of Carbon Dioxide and Carbon 
Monoxide. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50015 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response - Cal 1 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous, inorganic acid solution. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless, odorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  
Unusual Fire and Explosions Hazards: Emits toxic fumes under fire conditions. 

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if inhaled or swallowed. May be harmful if absorbed through the skin.  
Causes severe eye irritation. May cause skin irritation. 
First Aid: In case of contact, immediately flush eyes or skin with copious amount of water. 
Assure adequate flushing of the eyes by separating the eyelids with fingers. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
Wash contaminated clothing before reuse. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Bases. 
Hazardous Combustion or Decomposition Product: Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid inhalation. 
Do not get in eyes, on skin or on clothing. Avoid prolonged or repeated exposure. Wash 
thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50016 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response - Cal 2 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous, inorganic acid solution. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless, odorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  
Unusual Fire and Explosions Hazards: Emits toxic fumes under fire conditions. 

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if inhaled or swallowed. May be harmful if absorbed through the skin.  
Causes severe eye irritation. May cause skin irritation. 
First Aid: In case of contact, immediately flush eyes or skin with copious amount of water. 
Assure adequate flushing of the eyes by separating the eyelids with fingers. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
Wash contaminated clothing before reuse. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Bases. 
Hazardous Combustion or Decomposition Product: Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid inhalation. 
Do not get in eyes, on skin or on clothing. Avoid prolonged or repeated exposure. Wash 
thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50017 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response - Cal 3 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous, inorganic acid solution. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  
Unusual Fire and Explosions Hazards: Emits toxic fumes under fire conditions. 

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if inhaled or swallowed. May be harmful if absorbed through the skin.  
Causes severe eye irritation. May cause skin irritation. 
First Aid: In case of contact, immediately flush eyes or skin with copious amount of water. 
Assure adequate flushing of the eyes by separating the eyelids with fingers. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
Wash contaminated clothing before reuse. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Bases. 
Hazardous Combustion or Decomposition Product: Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid inhalation. 
Do not get in eyes, on skin or on clothing. Avoid prolonged or repeated exposure. Wash 
thoroughly after handling. Keep tightly closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50018 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response - QC 1 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

An aqueous solution of inorganic salt. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Water Spray, Carbon Dioxide, Dry Chemical Powder or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhalation, ingestion or skin absorption. May cause irritation.  
To the best of our knowledge, the chemical, physical and toxicological properties have not been  
thoroughly investigated. 
First Aid: In case of contact, immediately flush eyes with copious amount of water. 
In case of contact, immediately wash skin with soap and copious amount of water. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Alkali Metals (e.g. Lithium, Sodium). 
Hazardous Combustion or Decomposition Product: None. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin and clothing. Do not breathe vapor. Wash thoroughly after handling. Keep tightly 
closed. 

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50019 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response - QC 2 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A diluted aqueous solution of a weak organic base, slightly alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Water Spray. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. 
First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If swallowed, wash out mouth with water, provided person is conscious. Call a physician. 
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Section VII: REACTIVITY DATA 
 

Incompatibles: Anionic agents and nitrates. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide, 
Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50020 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response Activator 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

Inorganic aqueous solution, acidic to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder, Alcohol or Regular Foam. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  
Unusual Fire and Explosions Hazards: Emits toxic fumes under fire conditions. 

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: May be harmful by inhalation, ingestion or skin absorption. Causes eye and skin  
irritation.  
First Aid: In case of eye contact, immediately flush eyes with copious amount of water. In case of 
skin contact, immediately wash skin with soap and copious amount of water. 
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If inhaled, remove to fresh air. If not breathing, give artificial respiration. If breathing  
becomes difficult, give oxygen. 
If swallowed, wash out mouth with water, provided person is conscious.  
Call a physician. 

 
Section VII: REACTIVITY DATA 
 

Incompatibles: Strong bases, strong oxidizing agents, air sensitive, moisture sensitive. 
Hazardous Combustion or Decomposition Product: Sulfur Oxides. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Avoid contact with 
eyes, skin and clothing. Avoid prolonged exposure. Wash thoroughly after handling. Irritant. 
Store in a cool dry place.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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MATERIAL SAFETY DATA SHEET    50021 

 
InVitro International 

17751 Sky Park East, Ste. G 
Irvin, CA 92614 

Telephone: (714) 851-8356 
Fax: (714) 851-0563 

 
FOR EMERGENCY INFORMATION CALL: 
       1-800-535-5053 

 
Section I: PRODUCT IDENTIFICATION 
 
Product Name: High Sensitivity Dermal Response 
  Inhibition Check 
 
 SPECIFIC CONTENTS ARE TRADE SECRET 

 
Section II: HAZARDOUS COMPONENTS 
 

A diluted aqueous solution of a weak organic base, slightly alkaline to litmus. 
 

Section III: TOXICITY HAZARDS 
 

Irritation Data: NA 
Toxicity Data: NA 

 
Section IV: PHYSICAL DATA 
 

Appearance: Colorless liquid. 
 

Section V: FIRE AND EXPLOSION HAZARD 
 

Extinguishing Media: Carbon Dioxide, Dry Chemical Powder or Water Spray. 
Special Firefighting Procedure: Wear self contained breathing apparatus and protective clothing  
to prevent contact with skin and eyes.  

 
Section VI: HEALTH HAZARD DATA 
 

Acute Effects: Harmful if swallowed. 
First Aid: In case of contact, flush eyes or skin with copious amount of water. 
If swallowed, wash out mouth with water, provided person is conscious. 
Call a physician. 
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Section VII: REACTIVITY DATA 
 

Incompatibles: Anionic agents and nitrates. 
Hazardous Combustion or Decomposition Product: Carbon Monoxide, Carbon Dioxide, 
Hydrogen Chloride Gas. 

 
Section VIII: SPILL OR LEAK PROCEDURES 
 

Steps To Be Taken if Material is Released or Spilled: Wipe spilled material with a dry cloth or  
absorb in sand. Place in a container for later disposal. Wash spill site after materials pick  
up is complete. 

Waste Disposal Method: The substance can be disposed of as regular waste. 
 

Section IX: PROTECTIVE EQUIPMENT AND CONTROL MEASURES 
 

Wear chemical-resistant gloves, safety goggles and other protective clothing. Do not get in eyes, 
on skin or on clothing. Avoid prolonged or repeated exposure. Wash thoroughly after handling.  

 

 
 

 
Copyright 1995 In Vitro International 
License granted to make unlimited copies for internal use only. 
 
 

The above information is believed to be correct but does not 
purport to be all-inclusive and shall be used only as a guide. 
In Vitro International shall not be held liable for any damage 
resulting from handling or from contact with the above 
product. The information contained herein is furnished 
without warranty of any kind and is intended for the use only 
by persons having adequate related technical skills and at 
their own discretion and risk. Users should consider these 
data only as a supplement to other information gathered by 
them and must make independent determinations of the 
suitability and completeness of information from all sources 
to assure proper use and disposal of these materials and the 
safety and health of employees and customers. 
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IRRITECTION ASSAY SYSTEM Y2K UPDATE 
 

I. The High Sensitivity kits are no longer available because we found that the regular 
Ocular kits can provide as good resolution as the High Sensitivity Ocular kits and at the 
same time provide an overall picture (over a scale of 0 – 51). The regular Dermal assay 
correlates to human data, while the High Sensitivity Dermal assay correlated to rabbit 
data. Therefore, we now encourage our customer to use the regular ocular as well as 
Dermal Irritection Assay System. 

 
II. The Irritection software is compatible with the following plate readers: Dynex MRX, 

Dynatech MR600 / MR700, Dynatech MR5000 / MR7000, Molecular Devices Emax / 
Vmax / UVmax / THERMOmax, Cambridge 7520, Tecan and Thermal Lab Systems 
plate readers. 

 
III. Starting in January 2000, the volume of Blanking Buffer in both the Ocular and Dermal 

kits has changed from 40mL to 30mL. Please note that the amount of activator added has 
changed from 800 µl to 600 µl and 2400 µl to 1800 µl respectively for Ocular cosmetic 
and surfactant kits (Refer to chapter 3, page 6 and page 30); For Dermal kits the amount 
of activator added has changed from 920 µl to 690 µl (Please refer to chapter 3, page 18 
and 42). 

 
IV. A few groups of chemicals are known to be difficult or even incompatible with the 

protein reagents that are utilized in IAS Ocular and Dermal Assays. An such example is 
the group of acidic formulations (pH < 2.0); another the alkaline formulations (pH >0.0). 
These have a tendency to cause false negative results. In addition, intensely colored 
materials get high OD readings for blanks and samples. For the successful management 
of these potential problems, please refer to Chapter 6. 

 
V. A most frequent cause for a failed assay is not stirring the reagent wells thoroughly, 

especially the wells Cal2, Cal3, and QC2. Please use the wooden stirring sticks provided 
to scrape the reagent wells to ensure that all of the precipitate is removed from the bottom 
of each well and take care not to splash. 

 
 


